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Clarification de la notation 
NOTE:  
Ce type de paragraphe attire une attention des lecteurs sur un avis ou un thème lié. 
 
PRUDENCE !  
Ce type de paragraphe met en évidence une procédure, un réglage etc., qui peut entrainer un 
dommage ou une fonction non conforme des équipements si elle n’est pas correctement exécutée.  
 
 
AVERTISSEMENT !  
Ce type de paragraphe indique les détails, les procédures, réglages etc. qui requierent une attention 
très particulière faute de quoi peut causer des dommages corporelles.  
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Indications générales 

Description du logiciel GenConfig 
GenConfig est un logiciel de configuration basé sur un environnement Windows 2000/XP/Vista qui 
assure les fonctions suivantes :  

• Lire/écrire une configuration à partir/dans un contrôleur 
• Charger une configuration à partir d’un fichier, sauvegarder dans un fichier 
• Modifier la configuration du contrôleur 
• Metter à jour le firmware du contrôleur 
• Régler les valeurs des consignes de réglages 

 

 

NOTE:  
Le logiciel GenConfig supporte les contrôleurs InteliGen-NT®, InteliSys-NT® et InteliMains-NT®.  
 

Installation 
Exécuter le lot d’installation "ComAp PC Suite" (ex. IGS-NT-Install-Suite-2.4.exe) pour installer  le 
logiciel GenConfig, le microprogramme et les autres composants sur votre ordinateur. Si le logiciel 
GenConfig est déjà installé alors le programme d'installation proposera une mise à niveau (si votre 
version actuelle est plus ancienne) ou une réinstallation (si votre version actuelle est identique). 
Si votre version actuelle est ancienne, il est alors recommandé d'effectuer une mise à niveau si le 
microprogramme du contrôleur que vous êtes sur le point d'installer ne peut pas être compatible avec 
les anciennes versions du logiciel Genconfig.  
 
NOTE:  
La dernière version du microprogramme de la branche standard du contrôleur sera installée avec le 
logiciel GenConfig. Les nouveaux microprogrammes peuvent être installés ultérieurement avec le 
logiciel GenConfig en utilisant l’importation des programmes d’application IGC.  
Voir le chapitre Mise à jour du Firmware.  
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Répertoires du logiciel GenConfig  

 
 
STRUCTURE DU REPERTOIRE DU LOGICIEL GENCONFIG 
 
 

Configuration matériel requise du PC 
Le logiciel GenConfig est basé sur un environnement Windows 2000/XP/Vista/Windows 7. Utilisez un 
PC approprié pour cette plateforme. Il n'existe pas de prescriptions particulières pour le matériel.  

Le logiciel Genconfig nécessite environ 10 Mo d'espace libre sur disque. 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

6 



 
 

 

Modes de base et avancés 
Il existe deux modes de programme disponibles. Le mode de base ‘basic’ s’adapte aux 
personnes qui ne nécessitent pas de caractéristiques particulières du contrôleur et préfère une 
interface programme plus simple avec moins de réglages ect. Le mode avancé ‘advanced’ est 
destiné aux personnes qui ont besoin de toutes les fonctions et caractéristiques. 
 

Cliquer alors sur le menu OPTIONS -> SETTINGS -> DISPLAY pour sélectionner le mode programme. 

NOTE:  
Chaque archive mémorise le dernier mode utilisé sous GenConfig. Si une archive a été modifié en 
mode avancé (advanced), il n'est plus possible de travailler avec cet archive en mode Basic. Chaque 
fois que l'archive sera ouverte (depuis le contrôleur ou à partir d'un fichier) Genconfig basculera en 
mode avancé (Advanced) temporairement s'il était en mode Basic avant l'ouverture  
 
NOTE:  
Les archives des anciennes versions qui ne supportent pas le mode Basic seront ouvertes 
automatiquement en mode avancé. 
 

Archive versus Configuration 
Le tableau ci-dessous explique la signification des termes archive et configuration ainsi que la 
différence entre eux. 

 

Archive 

Paquet de données qui est extrait du contrôleur et pouvant être stocké dans un 
fichier. L'extension du fichier pour les archives de la série IGS-NT est "ant".  
Une archive contient les données suivantes :  

• Configuration  
• Points de consigne  
• Valeurs courantes  
• Historique (horadatage, journal des valeurs)  

Des Archives par défaut sont distribuées avec les firmwares des contrôleurs et 
contiennent les points de consignes et de configuration par défaut (configuration 
d'usine). Ces archives ne contiennent pas de données réelles ou d'historique. 

Configuration 

Une partie des données (stockée dans la mémoire flash du contrôleur), qui 
contient les propriétés des modules connectés, les entrées, les sorties, les 
languages (et traduction), les fonctions PLC et d'autres informations. La 
configuration peut uniquement être changée avec GenConfig. Normalement la 
configuration n'a besoin d'être changée que pour adapter le contrôleur à un 
changement de l'installation d'un site. De ce fait, il n'est plus nécessaire de 
changer la configuration durant toute la vie du générateur. 
NOTE:  
La Configuration est contenue dans chaque archive ! 
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Vérification de la version du logiciel GenConfig 
Cliquer sur les menus Help puis About pour afficher la fenêtre de la version GenConfig actuelle. 
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Utilisation de GenConfig 
En principe le logiciel GenConfig devrait être utilisé comme un utilitaire hors ligne (non connecté au 
contrôleur) pour créer, modifier la configuration et l'écrire dans le contrôleur. La communication 
s'effectue avec le contrôleur uniquement pendant la lecture ou l'écriture des données du contrôleur. 
Durant cette phase, vous verrez le serveur InteliDDE se lancer. 

NOTE:  
Même si GenConfig peut être lancé directement depuis le menu Window, il est possible de le lancer 
depuis le programme InteliMonitor:  
 

1. Démarrer InteliMonitor et cliquer sur Connection -> Open pour afficher la fenêtre Open 
connection.  

2. Créer un nouveau site/Générateur dans la fenêtre Open connection si nécessaire ou 
sélectionner Quick connect to controller si vous ne voulez pas utiliser la notion de site.  

3. Sélectionner le type de connexion souhaité et cliquer sur le bouton Open connection.  
4. Une fois la connexion effectuée (la barre d’état du logiciel InteliMonitor est en vert..) 

démarrer GenConfig en cliquant sur Tools -> GenConfig. GenConfig lira automatiquement 
la configuration du contrôleur.   
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Démarche type 
Le diagramme suivant montre la démarche typique dans l'utilisation de GenConfig: 

 
 

DEMARCHE TYPIQUE DE L’UTILISATION DE GENCONFIG 
 

Ouvrir une archive à partir du disque 

Cliquer sur l’icône   ou sélectionner File -> Open  pour activer la fenêtre de sélection des fichiers 
archives par défaut. 

Les archives par défaut sont situées dans le dossier fichiers partagés C:\Documents and 
Settings\All Users\Documents\ComAp PC Suite\GenConfig\Archives\Default 

Les archives crées par l’utilisateur sont destinées à être placées aussi dans le dossier fichiers 
partagés : C:\Documents and Settings\All Users\Documents\ComAp PC 
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Suite\GenConfig\Archives, Toutefois ils peuvent être lus depuis n'importe quel endroit dans 
l'ordinateur. 
. 

Lecture d’une archive à partir du contrôleur 

Cliquer sur l'icone   ou utiliser le menu File -> Read from controller pour extraire l'archive du 
contrôleur connecté. 

ATTENTION!  
Assurez vous que les Paramètres de connexion sont corrects avant d’effectuer la lecture de l’archive. 
Une mauvaise configuration de la connexion peut vous amener à lire l’archive d’un autre contrôleur (si 
plusieurs contrôleurs sont reliés ensemble).  
 
NOTE:  
Si GenConfig est lancé depuis le logiciel InteliMonitor, alors les paramètres de connexion sont repris 
de ce dernier et la lecture de l’archive contenu dans le contrôleur se fera automatiquement.  
 

Ecrire une configuration dans le contrôleur 

Cliquer sur l’icône   ou utiliser le menu FILE -> WRITE TO CONTROLLER pour écrire la configuration 
dans le contrôleur connecté. Pour compléter l’opération, le terme Administrator est affiché pour 
identification et le mot de passe est requis. Les options suivantes sont liées à l’écriture de la 
configuration :  

• Remplacer les points de consigne 
• Effacer l’historique 

 

ATTENTION!  
Assurez vous que les Paramètres de connexion sont corrects avant d’effectuer la lecture de l’archive. 
Une mauvaise configuration de la connexion peut vous amener à lire l’archive d’un autre contrôleur (si 
plusieurs contrôleurs sont reliés ensemble ou spécialement en cas de connexion ethernet).  
 
NOTE:  
Si GenConfig est lancé depuis le logiciel InteliMonitor, alors les paramètres de connexion sont repris 
de ce dernier et ne requière pas la même attention.  
 

Sauvegarder une archive dans le disque dur 

Cliquer sur l’icône   ou utiliser le menu FILE -> SAVE pour sauvegarder l’archive sur le disque dur. 
Si un nom du fichier n’a pas été donné à l’archive, une fenêtre de dialogue s’affichera, sinon l’archive 
sera sauvegardée sous le nom de fichier précédemment attribué. 

Utiliser le menu FILE -> SAVE AS pour sauvegarder l’archive sous un autre nom de fichier. 

Les options suivantes sont liées à la sauvegarde de l’archive:  

• Sauvegarder l’historique dans l’archive 
• Vérifier la cohérence avant de sauvegarder 
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Importer une configuration 
Si vous voulez utiliser une configuration depuis une archive qui n’est pas directement compatible avec 
le firmware de votre contrôleur, l’importation doit être utilisée pour importer la configuration de 
l’archive originale dans l’archive par défaut correspondant au firmware. 

1. Ouvrir l’archive par défault qui doit recevoir la configuration d’une autre archive. 
2. Aller dans le menu FILE -> IMPORT CONFIGURATION WIZARD 
3. Sélectionner l’archive source et appuyer sur le bouton NEXT.  
4. La fenêtre suivante affiche les différences entre les deux configurations. Aucune modification 

ne peut être faite à partir de cette fenêtre. 
5. Appuyer sur le bouton NEXT pour exécuter l’importation.  
6. Quand l’importation est terminée, appuyer sur le bouton NEXT pour faire apparaître le rapport 

de l’importation. Ce rapport fera état des avertissements et erreurs qui sont intervenus lors de 
l’importation.  

7. Appuyer sur le bouton OK pour fermer la fenêtre.  

ATTENTION!  
Vérifier la nouvelle configuration spécialement lorsque le rapport fait état d’avertissements ou 
d’erreurs. Une correction manuelle est alors requise si la configuration a été importée d’une version de 
firmware différente ou d’une application différente (certaines fonctions peuvent ne pas exister dans le 
firmware de destination).  
 

Compatibilité des archives 
Compatibilités des archives :  

• Les archives d’une version d’un même firmware et d’une version majeure ou mineure 
identique (ex. IG-NT-2.3 x IG-NT-2.3.1 x IG-NT-2.3.2) 

Archives non compatibles:  

• Les archives d’une version majeure ou mineure différentes d’un même firmware (ex IG-NT-2.2 
x IG-NT-2.3) 

• Les archives provenant de firmware d’une autre gamme 
• Les archives de différents types de contrôleur (IG-NT x IS-NT) 

 

Mise à jour du logiciel interne du contrôleur 
Bien que les contrôleurs soient toujours livrés avec la dernière version du firmware (logiciel interne), il 
peut être nécessaire dans certains cas de mettre à niveau celui-ci avec une version plus récente. 
Également les branches de firmwares personnalisées exigent une reprogrammation du contrôleur. 

NOTE:  
Administrator est affiché pour identification avant la programmation du firmware et/ou la 
configuration du contrôleur.  
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Importation de nouveau firmware 

• Aller dans le menu OPTIONS -> IMPORT FIRMWARE pour importer le nouveau firmware (obtenu 
par e-mail, téléchargé sur un site, etc.) dans le logiciel GenConfig.  

• La fenêtre "Import firmware" apparaît. Cliquer sur l’icône   et sélectionner le fichier  avec 
l’extention IGC qui doit être importé.  

• Dans la partie basse de la fenêtre apparaîtra le contenu du fichier IGC. 
• Il est possible de cocher/décocher les fichiers qui doivent être importés 
• Sélectionner la méthode d’écrasement des fichiers déjà existants 
• Appuyer sur le bouton "Import" pour importer le firmware dans le logiciel GenConfig. 

 
 

Mise à jour du logiciel interne (configuration par défaut) 
NOTE:  
Cette fonction est destinée à la programmation de nouveaux contrôleurs ou à la programmation d’un 
nouveau firmware. Pour mettre à jour le firmware d’un contrôleur déjà opérationnel, utiliser la fonction 
Mise à jour du micro programme (configuration existante).  
 
La fonction FIRMWARE UPGRADE (DEFAULT CONFIGURATION) implantera le firmware sélectionné dans le 
contrôleur. Après la programmation du logiciel interne, le contrôleur contiendra l’archive par défaut 
(l’application SPtM dans le cas de la gamme standart) qui devra être modifiée pour s’adapter à 
l’application requise. Voir le chapitre Configuration du contrôleur pour plus d’informations sur comment 
modifier la configuration. 
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Sélectionné le firmware requis dans la liste et cliquer sur le bouton OK. Si le firmware n’apparaît pas 
dans la liste, il faudra en premier lieu l’importer. 

ATTENTION!  
Ne pas implanter le firmware d’un IS-NT dans un controleur IG-NT et inversement! 
 

Mise à jour du logiciel interne (configuration existante) 
NOTE:  
Cette fonction est utilisée pour la mise à jour du firmware d’un contrôleur déjà opérationnel. Pour 
implanter un firmware dans un nouveau contrôleur ou implanter le firmware d’une branche différente, 
utiliser la fonction Mise à jour du micro programme (configuration par défaut).  
 
La fonction FIRMWARE UPGRADE (EXISTING CONFIGURATION) éffectue automatiquement les opérations 
suivantes :  

1. L’archive est extraite du contrôleur et sauvegardée dans un fichier. 
2. Une fenêtre avec les firmwares disponibles et les archives par défaut s’affiche. Sélectionner 

dans cette fenêtre le nouveau firmware à appliquer. Si le nouveau firmware n’est pas 
compatible avec l’archive originale alors une archive par defaut doit être sélectionné.  

 
 
FIRMWARE SELECTIONNE INCOMPATIBLE 
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FIRMWARE SELECTIONNEE COMPATIBLE 

3. Si le nouveau firmware n’est pas compatible avec l’archive originale alors une importation de 
la configuration originale sera effectuée dans la configuration par défaut sélectionné.  

4. Le firmware sélectionné est implanté dans le contrôleur. 
5. La configuration est programmée dans le contrôleur. 
6. Les Consignes de l’archive sont écrites dans le contrôleur.  

 

NOTE:  
Cette fonction devrait réduire les efforts nécessaires à la mise à jour d’un contrôleur qui est installé sur 
un site. Cependant, les nouveaux firmwares peuvent apporter des modifications aussi bien sur le 
fonctionnement que sur des nouvelles fonctions et l’opération est à effectuer avec précaution. 
Veuillez toujours lire attentivement les nouvelles fonctionnalités du firmware dans le document 
joint (New Features) 
 

Clonage 
Utiliser la fonction de clonage pour créer une copie identique d’un contrôleur dans un autre contrôleur. 
La fonction peut être utile dans les situations suivantes:  

• Remplacement d’un contrôleur défectueux par un nouveau contrôleur sur le site. 
• Production de plusieurs unités identiques. 

 

La procédure se passe en deux étapes:  

1. Sauvegarder pour un clonage ultérieur 
2. Créer un clone 

Contenu d’un clone  

• Fichier descriptif du clone 
• Archive du contrôleur 
• Firmware du contrôleur correspondant à l’archive 
• Firmware des afficheurs externes (optionnel, pour les terminaux connectés via la ligne dédiée 

RS485) 
• Les polices graphiques (optionnel, seulement pour les contrôleurs et terminaux qui supportent 

les polices graphiques) 
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Sauvegarder pour clonage ultérieur 
La fonction SAVE FOR LATER CLONNING (CONTROLLER ONLY) sauvegardera la configuration actuellement 
ouverte incluant toutes les modifications qui ont été faites depuis son ouverture depuis un fichier ou 
depuis le contrôleur. Cette option ne sauvegarde pas les firmwares des terminaux externes et les 
polices graphiques dans le clone. 

La fonction SAVE FOR LATER CLONNING (CONTROLLER AND DISPLAYS) se connecte automatiquement au 
contrôleur, lit la configuration de celui-ci et la sauvegarde dans le fichier clone. Les firmwares des 
terminaux externes connectés via le bus dédié RS 485 et les polices graphiques sont sauvegardés 
dans le fichier clone. 

NOTE:  
Si vous avez un message d’erreur du style "Firmware XXXX was not found" durant l’ouverture de la 
fenêtre "Save clone", cela veut dire que le firmware présent dans le contrôleur n’est pas présent sur le 
disque alors le fichier clone ne peut pas être sauvegardé. Dans ce cas il faut importer le firmware 
dans le logiciel GenConfig.  
 
Créer un clone 
Utiliser la fonction CREATE CLONE... pour faire du contrôleur actuellement une copie conforme 
(firmware, configuration, consignes, police…) du contrôleur d’origine ayant servi à faire le fichier clone. 
La fonction est destinée soit à faire une sauvegarde complète d’un site dans le cas où le contrôleur 
aurait besoin d’être remplacé, soit dans la préparation de plusieurs contrôleurs identiques. 

1. Connecter le contrôleur de destination (avec afficheur si nécessaire) au PC. 
2. Démarrer GenConfig et ajuster correctement les paramètres de connexion.  
3. Aller dans le menu FILE -> CREATE CLONE... et sélectionner le clone requis.  

Appuyez sur le bouton OK pour cloner le contrôleur.  

Importer/Exporter un clone 

Cliquer sur le bouton   pour exporter l’image sélectionnée et sauvegardé dans un fichier à des 
fins d’archivage, d’envoi par courriel, etc.  

Cliquer sur le bouton   pour importer une image précédemment exportée dans le logiciel 
GenConfig. 
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Programmation du firmware d’un contrôleur ne répondant plus 
Si le contrôleur ne contient pas un firmware valide, un nouveau firmware ne pourra pas être implanté 
suivant la procédure classique. Cette situation peut arriver si la connexion entre le PC et le contrôleur 
est interrompue durant une programmation. Dans ce cas, le contrôleur affiche un écran vide et ne 
communique plus avec l’ordinateur. Le cavalier ‘Boot’ doit être utilisé pour pouvoir implanter un 
firmware conforme dans le contrôleur. 

1. Déconnecter l’alimentation du contrôleur et fermer le cavalier ‘boot’. Voir le manuel du 
contrôleur pour localiser le cavalier.  

2. Connecter via un cable de communication (de type approprié au protocole utilisé) le contrôleur 
avec l’ordinateur. 

3. Sélectionner une connexion directe vers le contrôleur avec comme adresse 1. 
4. Aller dans le menu CONTROLLER -> PROGRAMMING AND CLONNING -> FIRMWARE UPGRADE, 

sélectionner le firmware approprié et cliquer sur le bouton OK.  
5. Suivre les instructions données à l’écran et cliquer sur le bouton OK pour finir.  
6. Un autre message apparaîtra lorsque la programmation sera terminée. Suivre alors les 

instructions. 
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Configuration du contrôleur 
L’une des particularités clé du contrôleur est son haut niveau d’adaptabilité du système aux besoins 
de chaque cas d’application particulière. La manière de réaliser ceci passe par la configuration. 

Le firmware contient un grand nombre d’entrées et sorties logiques nécessaire pour toutes fonctions 
indispensables disponibles. Mais toutes les fonctions ne sont pas requis en même temps  sur un 
même groupe et l’architecture matériel du contrôleur n’a pas autant d’entrée et de sorties physique. 
L’une des fonctions principales de la configuration est  d’attribuer les entrées et sorties logiques du 
firmware vers des entrées et sorties physique matériel. 

 
 
PRINCIPE DE LA CONFIGURATION DES ENTREES ET SORTIES BINAIRES  
 

Etapes essentielles de la configuration 
Les étapes de configuration qui suivent doivent être effectuées dans la plupart des applications:  

1. Ouvrir une archive par défaut du type de l’application requise correspondant à la version du 
firmware et la branche du contrôleur 

2. Définir les modules qui seront contenus dans le système (ex. ECU moteur et/ou modules 
d’extension)  

3. Attribuer les fonctions et/ou protections aux entrées physiques (entrées du contrôleur), 
attribuer les fonctions aux sorties physiques (sortie du contrôleur)  

4. Attribuer les droits d’accès aux points de consignes, ajuster les valeurs initiales des points de 
consignes. 
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Etapes optionnelles de configuration 
Les étapes de configuration suivantes ne sont utiles que dans le cas d’application complexe:  

1. Attribuer les droits d’accés pour les commands de contrôle à distance du groupe 
2. Créer des protections additionnelles à toutes les valeurs analogiques  
3. Modifier le contenu de la structure de l’historique 
4. Créer des sondes analogiques personnalisées 
5. Ajouter/Effacer des langues du contrôleur, traduire les textes  
6. Créer des connexions internes entre des sorties logiques et des entrées logiques 
7. Créer des programmes PLC pour le contrôle de technologie additionnelle 

NOTE:  
Il existe deux modes de travail de GenConfig – Le mode Basic et le mode Advanced. Certaines 
particularités sont cachées avec le mode Basic. Voir le chapitre Mode de base ou mode avancé pour 
plus de détails. 

Protection d’archive  
Il est possible de protéger les archives contre un usage non autorisé. Si l’archive est vérouillé, le mot 
de passe de l’utilisateur 0 (mot de passe administrateur) est requis pour ouvrir et afficher l’archive 
avec le logiciel GenConfig. 

NOTE:  
Le verrouillage de l’archive fonctionne uniquement sir la configuration a été récupérée du 
contrôleur et que le mot de passe requis était valid au moment de la récupération. Le verrouillage de 
la configuration n’est pas active sur des archives qui sont basées directement sur une archive par 
défaut et qui n’a pas encore été transféré dans le contrôleur.  
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Modules 
MODULES 

C’est l’onglet principal où l’on commencera à définir la configuration. On y définit la configuration 
générale du système, par exemple le type de contrôleur, les modules d’extensions reliés, le type 
d’ECU et autres périphériques.  

• La partie de gauche de l’onglet contient l’arborescence de tous les modules disponibles.  
• La partie de droite affiche les modules actuellements configurées et leurs propriétés.  

 

 
ONGLET MODULES 
 
Ci-dessous les instructions pour préparer une configuration personnalisée à partir d’une configuration 
par défaut (d’usine):  

1. Sélectionner le type du contrôleur qui est utilisé dans la liste de gauche et appuyer sur le 
bouton INSERT  pour ajouter le contrôleur à votre système. A noter qu’il n’est pas possible de 
basculer d’un contrôleur IG-NT à un IS-NT et inversement. Pour ce cas il faut ouvrir des 
archives différentes ou les contrôleurs IG-NT et IS-NT seront configurés.  

2. Si un moteur est équipé d’une injection éléctronique (avec un ECU), sélectionner le type 
souhaité dans l’arborsence de gauche et appuyer sur le bouton INSERT pour ajouter l’ECU à 
votre système.  

3. Sélectionner l’ECU dans la partie de droite et ajuster ces propriétés:  
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• ECU SIZE défini le nombre d’entrées et de sorties qui sera disponible pour configurer 
les valeurs ECU dans l’onglet I/O.  

• PROTECTION UPON MODULE FAILURE sélectionner le type de l’alarme qu’entrainera une 
perte de la communication entre l’ECU et le contrôleur.  

• Utiliser DISPLAY DATA AS pour sélectionner la façon d’afficher les valeurs de l’ECU : 
bargraphe ou valeurs numériques seulement.  

4. Sélectionner les modules d’extensions appropriés dans la liste de gauche et les insérer un par 
un à votre configuration. 

5. Sélectionner chaque module d’extension dans la partie de droite et définir les propriétés de 
chacun:  

• MODULE INDEX doit correspondre au paramètre d’adressage du module. L’image dans 
la partie basse de la fenêtre affiche des informations sur comment paramétrer 
l’adresse d’un moduel. Normalement il n’est pas nécessaire de modifier l’index du 
module. Il est défini automatiquement lors de l’insertion du module.  

NOTE:  

Certains modules se partagent des adresses CAN physiques et dans ce cas 
l’utilisation d’un type de module avec une adresse spécifique désactivera un autre 
module utilisant le même index. Exemple: si le module AIN8 avec les indexes 1 - 4 est 
configuré, il n’est pas possible de configurer le module IGS-PTM, vu que le module 
IGS-PTM avec les indexes 1-4 partage les adresses CAN avec le module AIN8. Dans 
ce cas, la solution consiste à configurer le module AIN8 avec les indexes 2-5 et le 
module IGS-PTM avec l’index 1.  

 

• PROTECTION UPON MODULE FAILURE Sélectionne le type d’alarme qui se déclenchera 
lorsque le module cessera de communiquer avec le contrôleur.  

• Utiliser DISPLAY DATA AS pour sélectionner la manière dont seront affichées les valeurs 
analogiques lues : en barregraphe ou la valeur seulement.  

 

Contrôleur 
Version antèrieure au firmware 2.5  

Le contrôleur type possède une configuration fixe qui ne peut être changée dans l’archive. Il y a 
différentes archives par défaut pour les contrôleurs IG-NT et IS-NT. 

Modifier le type de contrôleur n’est possible que du IG-NT vers le IG-EE et inversement. 

Version Supèrieur au firmware 2.5 

Il y a plusieurs groupes de contrôleur dont la modification matériel interne est compatible et un 
firmware et archive séparé pour chaque groupe. Les groupes sont les suivants : 

VERSION DES CONTROLEURS COMPATIBLES FICHIER FIRMWARE FICHIER ARCHIVE 

IG-NT, IG-NTC, IG-EE(C), IG-NT-BB, IG-NTC-BB Ig-nt-x.y.z.mhx Ig-appl-x.y.ant 

IS-NT, IS-NTC-BB Is-nt-x.y.z.mhs Is-appl.x.y.ant 

IM-NT, IM-NT-BB, IM-NTC-BB Im-nt-x.y.z.mhx Im-appl-x.y.ant 

 
Il est possible de changer une version de contrôleur par n’importe quel contrôleur compatible. Le 
logiciel Genconfig affichera ou masquera alors certaines consignes et éléments de configuration qui 
sont ou non supportés par la nouvelle version. 
 
 
Note : 
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Les archives par défaut de chaque groupe sont configurées respectivement pour l’IG-NT, IS-NT ou 
l’IM-NT. Cependant, pour avoir accès à toutes les fonctionnalités et fonctions que supportent votre 
contrôleur, vous devez changer le contrôleur dans la configuration pour qu’il corresponde au matériel 
physique. 
 
Exemple : 
L’archive par défaut IG-NT-MINT est ouvert avec la version matériel du contrôleur IG-NT, qui ne 
supporte pas les sorties au potentiel. Si vous avez un matériel IG-NT-BB, qui supporte des sorties au 
potentiel, vous devez changer la version par un contrôleur IG-NT-BB et alors vous pourrez choisir le 
type des sorties du contrôleur : au potentiel ou à la masse. 
 
Note : 
Si la version du contrôleur n’est pas correctement sélectionné, vous aurez accès à la configuration de 
toutes les fonctions qui ne marcheront pas sur le contrôleur cible et inversement. Cependant, le reste 
des fonctions qui sont supportées par toutes les versions marcheront normalement. 
 

 
 

1. Liste des versions de contrôleur compatible 
2. Cliquer sur le bouton pour changer la version par celle sélectionnée 
3. Version actuellement configurée 
4. Aperçu de la version sélectionnée 
5. Choix du type des sorties : négatives ou positives. 

 
 

ECU 
Sélectionner le type de l’ECU correspondant au moteur et l’ajouter à la configuration. La section ECU 
apparaîtra dans l’onglet I/O, où les entrées et les sorties de l’ECU seront configurées. 

La configuration de base réquise est faite automatiquement lorsqu’un module ECU est ajouté. Les 
propriétés requises à l’ECU dans la configuration sont indiquées en rouge (ex : l’entrée analogique 
logique de la vitesse du moteur). 
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EXEMPLE:  
Si l’ECU est configuré alors la vitesse du moteur sera obtenue par l’ECU à la place de celle en 
provenance du capteur magnétique. Ce qui implique que l’entrée analogique logique RPM PICKUP doit 
être configurée comme entrée analogique ECU où Engine speed est configurée comme valeur source 
ECU.  
 

 
PROPRIETE DE L’ECU REQUISE MANQUANT DANS LA CONFIGURATION 
 

 
 
PROPRIETE DE L’ECU CORRECTEMENT CONFIGUREE 
 
NOTE:  
Si une version particuliere du fichier ESF utilisée pour la configuration de l’ECU ne correspond pas 
avec la version actuelle du fichier ESF, le nom du moteur dans la barre d’état apparaît en rouge. Si 
des changements dans la configuration des entrées et sorties de l’ECU doivent être faites, 
retirer le module ECU dans l’onglet ‘modules’ et ajouter le à nouveau pour refaire la 
configuration ! 
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INDICATION QUE LA VERSION DU FICHIER ESF NE CORRESPOND PAS 
 

Modules d’extension 
Extension standard 
Le groupe STANDARD EXTENSION contient tous les modules d’extension ‘physiques’ qui peuvent être 
connectés au bus CAN1. 

Extension virtuelle  
Le groupe VIRTUAL EXTENSION contient tous les modules qui existent seulement sous forme virtuelle 
dans le firmware. Les entrées et sorties de ces modules peuvent être interconnectés avec d’autres 
modules seulement par des connexions logiques. 

• Module VPIO 
• Modules Partagés 

Passerelles ECU 
Les passerelles ECU (modules I-CB) sont disponibles pour les types de moteurs à gestion 
électronique qui ne supportent ni le protocol MODBUS, ni le protocol SAE J1939. Une passerelle ECU 
est connectée au bus CAN1 du contrôleur. Le module est perçu par le contrôleur comme un module 
d’extension qui contient un certain nombre de groupe d’entrées et/ou sorties analogiques ou binaires. 

NOTE:  
La configuration d’un module I-CB dans le contrôleur doit correspondre avec la configuration du 
module I-CB proprement dit. 
 
NOTE:  
Le firmware d’un module I-CB doit correspondre au type du moteur spécifique. 
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Comment configurer un module I-CB : 

1. Vérifier avant tout si le module I-CB contient le firmware approprié au type du moteur (ECU). 
Le type du firmware original et sa version sont indiqués sur le module I-CB par un autocollant.  

2. Avec le logiciel ICBEdit, ouvrir la configuration par défault de l’I-CB correspondant au type du 
moteur modifier la configuration si nécessaire et l’implanter dans le module I-CB. 

3. Utiliser le menu FILE -> EXPORT... du programme ICBEdit pour exporter la configuration du 
module vers un fichier texte.  

4. Dans le logiciel GenConfig, insérer le module I-CB correspondant dans la configuration et aller 
dans l’onglet I/O pour configurer les entrées et sorties.  

NOTE:  
Toujours utiliser le type sonde électronique pour les entrées analogiques de la passerelle ECU.  
 
Extension générique 
Il y a également de disponible une passerelle I-CB (GENERIC), qui n’est pas préconfigurée pour un 
moteur spécifique et qui ne contient par défaut aucune entrée et sorties. Les groupes des entrées et 
sorties doivent être alors configurées manuellement en utilisant les modules généric du groupe 
GENERIC EXTENSION. 
 

Modules d’extension virtuelle partagée 
Les modules d’extension virtuelle partagée sont prévus pour le transfert de signaux binaires et/ou 
analogiques d’un contrôleur source ver les autres contrôleurs via le bus de données CAN2. 

 

INDICATION QUE LA VERSION DU FICHIER ESF NE CORRESPOND PAS 

SHBOUT 

Le module SHBOUT est un bloc de 8 sorties binaires virtuelles. Les signaux configurés sur les sorties 
sont émis sur le bus CAN2 et peuvent être reçus par les autres contrôleurs sur le même bus utilisant 
le module SHBIN avec le même index que celui du SHBOUT. 

ATTENTION!  
Uniquement un seul contrôleur contenant un module SHBOUT avec un index particulier est autorisé 
sur une même installation. 
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SHBIN 
Le module SHBIN est un bloc de 8 entrées binaires virtuelles prévu pour recevoir les signaux binaires 
qui sont transmises par un module SHBOUT. 
 
NOTE:  
Le module de réception SHBIN doit avoir le même index que celui du module émetteur.  
 
SHAOUT 
Le module SHAOUT est un block de 4 sorties analogiques virtuelles. Les signaux configurés sur les 
sorties sont transmises via le bus CAN2 et peuvent être réceptionnés par les autres contrôleurs du 
même bus en utilisant le module SHAIN ayant le même index que celui du SHAOUT. 
 
ATTENTION!  
Uniquement un seul contrôleur contenant un module SHAOUT avec un index particulier est autorisé 
sur une même installation. 
 
SHAIN 
Le module SHAIN est un bloc de 4 entrées analogiques virtuelles prévu pour la réception des signaux 
analogiques qui sont transmises par un module SHAOUT. 
 
NOTE:  
Le module de réception SHAIN doit avoir le même index que celui du module émetteur.  
 
NOTE:  
Il faut toujours utiliser le type de sonde Electronic pour les entrées analogiques dans la configuration 
des modules SHAIN.  
 
DISTBOUT 
Le module DISTBOUT est un bloc de 8 sorties binaires virtuelles. Les signaux configurés sur les 
sorties sont transmises sur le bus CAN2 et peuvent être réceptionnés par les autres contrôleurs sur le 
même bus en utilisant le module DISTBIN ayant le même index que le DISTBOUT. DISTBOUT a 
toujours comme index l’adresse CAN du contrôleur. 
 
NOTE:  
Uniquement un seul module DISTBOUT peut être configuré par contrôleur.  
 
NOTE:  
Le module DISTBOUT est uniquement disponible sur les contrôleurs suivants : 
 
             1.  Les contrôleurs IG-NT(C)-BB avec le firmware 3.0 ou supérieur and le dongle LSM-PMS 

installé. Le module n’est pas disponible sur les versions IG-NT-GC 
2.  Les contrôleurs IS-NT avec le firmware 3.0 et supérieur et le dongle LSM-PMS installé 
3.  Les contrôleurs IM-NT avec le firmware 3.0 et supérieur (pas de dongle requis) 

  
 
DISTBIN : 
Le module DISTBIN est un bloc de 8 entrées binaires virtuelles prévu pour la réception des signaux 
binaires qui sont transmises par le module DISTBOUT 
 
NOTE:  
Le module de réception DISTBIN doit avoir l’index correspondant celui de l’émetteur (soit l’adresse du 
contrôleur qui émet ces signaux).  
 
NOTE:  
Jusqu’à 32 modules DISTBIN avec un index unique (de 1 à 32) peuvent être configurés par 
contrôleur.  
 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

26 



 
 

 

NOTE:  
Le module DISTBIN est uniquement disponible sur les contrôleurs suivants : 
 
             1.  Les contrôleurs IG-NT(C)-BB avec le firmware 3.0 ou supérieur and le dongle LSM-PMS 

installé. Le module n’est pas disponible sur les versions IG-NT-GC 
2.  Les contrôleurs IS-NT avec le firmware 3.0 et supérieur et le dongle LSM-PMS installé 
3.  Les contrôleurs IM-NT avec le firmware 3.0 et supérieur (pas de dongle requis) 
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Entrées et sorties 
ONGLET I/O 

La Configuration des entrées et des sorties consiste à assigner les fonctions et/ou alarmes des 
entrées physiques (ou virtuelles) et à assigner les fonctions des sorties physiques. 

• Entrées Binaires 
• Sorties Binaires 
• Entrées Analogiques 
• Sorties Analogiques 

Entrées Binaires 
Une entrée binaire (binary input) peut être utilisée comme une entrée d’une fonction et/ou comme 
alarme (protection). 

Configurer une fonction binaire 
Suivre les instructions ci-dessous pour configurer une fonction en entrée:  

1. dans l’arborescence de gauche, sélectionner l’entrée physique qui doit être configurée. 
2. Cocher la case ‘Function’ dans la colonne centrale. 
3. Sélectionner l’entrée logique demandée (fonction) dans la liste de droite. Il est possible 

d’assigner plusieurs fonctions pour une seule entrée physique. 
4. Revenir dans la colonne centrale et remplir le champ NAME avec un nom de circonstance. La 

longueur du nom est limitée à 14 caractères.  

 
CONFIGURATION DUNE ENTREE BINAIRE COMME FONCTION 
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Configuration d’une protection binaire 
Suivre les instructions ci-dessous pour configurer une alarme sur une entrée:  

1. Dans l’arborescence de gauche, sélectionner l’entrée physique qui doit être configurée. 
2. Cocher la case "Protection" dans la colonne centrale. 
3. Remplir le champ NAME avec un nom de circonstance. La longueur du nom est limitée à 14 

caractères.  
4. Sélectionner le type de protection souhaitée (alarme). 
5. Sélectionner si l’alarme est activé lorsque le contact est fermé (l’entrée binaire est à la masse) 

ou ouvert (l’entrée binaire n’est pas à la masse). 
6. Sélectionner la période durant laquelle l’alarme sera active par exemple toujours, pendant la 

marche du moteur, lorsque le GCB est fermé, etc. 
7. Sélectionner le délai d’évaluation. Le délai standard est fixé à 500ms ce qui devrait convenir 

pour la plupart des applications, cependant il existe plusieurs délais ajustables qui peuvent 
être assignés à une entrée binaire pour éviter un délai fixe.  

 
CONFIGURATION D’UNE ENTREE BINAIRE EN TANT QU’ALARME (PROTECTION) 
 
 

Entrées binaires ECU 
La plupart des ECU délivrent plusieurs signaux binaires qui peuvent être repris comme entrées 
binaires au niveau du contrôleur. Le nœud "ECU" apparaîtra dans la section "binary inputs" dans 
l’arborescence de gauche si un ECU est configuré. Le nœud contiendra un ensemble d’entrées 
binaires virtuelles. Ces entrées binaires marchent de la même manière qu’une entrée physique à 
l’exception qu’ils requièrent une valeur source de l’ECU avant de pouvoir configurer la fonction ou la 
protection.  

 
CONFIGURATION D’UNE VALEUR SOURCE D’UNE ENTREE BINAIRE ECU  
 
 

NOTE:  
La configuration essentielle requise des entrées et sorties est faite automatiquement quand ECU est 
ajouté à la configuration. Voir le sous chapitre ECU dans le chapitre modules.  
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Sorties binaires 
Une sortie binaire peut être contrôlée par les sources suivantes:  

• Sorties binaires logiques (Sorties contrôlées par le programme interne) 
• Valeurs binaires à titre d’information 
• Reports d’alarme (alarmes internes, analogiques, ou binaires) 
• Reports des entrées binaires (physiques ou virtuelles) 

 

NOTE:  
Les sorties binaires des versions de contrôleurs IG-NT-BB, IG-NTC-BB, IS-NTC-BB, IM-NT-BB et IM-
NTC-BB peuvent être de type positif (au potentiel) ou négatif (0V). Voir le chaître Contrôleur. 

Configurer une sortie de contrôle 
Suivre les instructions suivantes pour configurer une sortie de contrôle :  

1. Dans l’arborescence de gauche, sélectionner la sortie physique qui doit être configurée. 
2. Sélectionner la sortie logique souhaitée (sortie contrôlée) dans le nœud ‘Log Bout’ située dans 

l’arborescence de droite. 
3. Le nom de la sortie physique est renomée automatiquement en fonction de la sortie logique 

assignée. Il peut être modifié depuis la colonne centrale. La longueur du nom est limitée à 14 
caractères.  

4. La fonction de la sortie physique peut être inversée. 

 
CONFIGURATION DU SORTIE BINAIRE COMME SORTIE DE CONTROLE 
 
 

Configurer une sortie report d’alarme 
Suivre les instructions suivantes pour configurer une sortie report d’alarme (protection):  

1. Dans l’arborescence de gauche, sélectionner la sortie physique qui doit être configurée. 
2. Sélectionner le report de l’alarme souhaitée depuis les noeufs ANA PROTECTIONS, BIN 

PROTECTIONS ou PRG STATES dans l’arborescence de droite.  
• ANA PROTECTIONS contient toutes les alarmes assignées aux entrées analogiques. 

Dans le champ LEVEL il est possible de sélectionner les niveaux de l’alarme qui seront 
reportés vers la sortie.  

• BIN PROTECTIONS contient toutes les alarmes attribuées aux entrées binaires.  
• PRG STATES contients toutes les alarmes internes y compris les alarmes générées par 

le bloc PLC ‘force protect’.  
3. Le nom de la sortie physique est attribué automatiquement en fonction de l’alarme assignée. Il 

peut être modifié dans la colonne centrale. La longueur du nom est limitée à 14 caractères.  
4. La fonction de la sortie physique peut être inversée. 
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CONFIGURATION D’UNE SORTIE BINAIRE COMME REPORT D’ALARME 
 

Sorties binaires ECU 
Certains ECU peuvent recevoir un ensemble de signaux binaires. Le nœud "ECU" apparaîtra dans la 
section "Binary outputs" dans l’arborescence de gauche si l’ECU est configuré. Le nœud contiendra 
l’ensemble des sorties binaires virtuelles. Ces sorties fonctionnent de la même manière que des 
sorties physiques mais requièrent une attribution à une valeur ECU destinataire avant de la 
configuration de la fonction source.  
 

 
CONFIGURATION VALEUR DE DESTINATION ECU POUR UNE SORTIE BINAIRE ECU  
 
 

NOTE:  
L’essentiel de la configuration requise des entrées et sorties ECU est faite automatiquement quand le 
module ECU est configuré. Voir le sous châpitre ECU du chapitre modules.  
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Entrées analogiques 
Une entrée analogique peut être utilisée comme une entrée fonctionnelle et/ou alarme (protection). 
Suivre les instructions ci-dessous pour configurer une entrée analogique: 

 
ETAPE DE CONFIGURATION D’UNE ENTREE ANALOGIQUE 
 

1. Sélectionner l’entrée analogique désirée. 
2. Saisir un nom approprié à l’entrée. 
3. Sélectionner l’unité physique de la valeur mesurée. L’unité propre physique dépend du type 

de la sonde. 
4. Sélectionner le type de la sonde. Il y a trois sortes de sondes:  

Sondes générales (Generales sensors) comme par exemple 0-10V peut mesurer 
différentes valeurs physiques avec différentes plages. Ces sondes fournissent une valeur 
électrique (ex Volts) qui nécessite une convertion supplémentaire pour obtenir une valeur 
physique. Un exemple d’une telle sonde est une sonde de pression de niveau de fuel 0-
50.0gal/0-10V. La conversion est linéaire et le ratio de la conversion a été ajusté par la 
propriété SENSOR RANGE (plage). La plage ajuste la valeur physique représentant la valeur 
haute de la plage électrique de la sonde (ex 50.0gal à 10V) 
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Définir les paramètres Bargraph 0% et Bargraph100% pour définir la limite basse et la limite 
haute de l’échelle du bargraphe (par exemple si vous voulez une échelle de bargraphe limitée 
de  40Hz à 70Hz). 

  
BAREGRAPHE AVEC EN PROPRIETE BARREGRAPH0%=40 ET BARREGRAPH100%=70 

Sondes dédiées (Dédicated sensors) comme les sondes PT100 ou Thermocouples sont 
converties directement en une valeur physique et ne requierent pas d’ajustement de la plage 
ou de la résolution. 

Sonde électronique (Electronic sensor) est utilisée pour toutes les entrées analogiques 
virtuelles. Aucune conversion n’est effectuée avec cette sonde et la valeur analogique en 
entrée est reçue telle quelle par le périphérique virtuel. 

NOTE:  

Si vous ne trouvez pas votre sonde dans la liste des sondes prédéfinies, reportez vous au 
chapitre Sondes utilisateurs pour plus d’information sur la manière de créer une sonde 
utilisateur personnalisée.  

 

5. Cocher la case FUNCTION si l’entrée analogique sera utilisée dans un but de contrôle, par 
exemple pour contrôler une fonction de chauffage du moteur.  

6. Si la case fonction (5) est cochée, sélectionner la fonction requise pour l’entrée. 
7. Cocher la case PROTECTION si une protection (alarme) sera assignée à l’entrée analogique.  
8. Si la case protection (7), configurer la protection :  
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ETAPE DE CONFIGURATION D’UNE PROTECTION D’UNE ENTREE ANALOGIQUE 

 

NOTE:  

Voir le guide de référence du contrôleur pour plus d’information sur le fonctionnement des 
protections. 

 

1. Sélectionner le type de la protection pour un niveau jaune (non critique). 
2. Sélectionner le type de la protection pour un niveau rouge (critique). 
3. Sélectionner si la protection sera active lorsque la valeur analogique est au dessus ou 

en dessous de la limite. En sélectionnant ...+Fls , la protection configurée de niveau 
rouge apparaîtra en cas de détection de défaillance de la sonde concernée. Si 
aucune protection de niveau rouge n’est configurée, la protection de niveau jaune se 
déclenchera.  

4. Sélectionner comment la protection sera enregistrée dans l’historique. ONCE signifie 
que seul le premier évènement sera enregistré tant que la touche ‘Fault Reset’ n’est 
pas pressée, ALWAYS signifie que tous les évènements seront enregistrées.  

5. Sélectionner la période pendant laquelle la protection sera active. Par exemple Oil 
pressure doit être seulement active lorsque le moteur tourne.  

6. Renommer les consignes de limite et de délai et ajuster les valeurs par défaut. Les 
consignes peuvent être réajustées à tout moment depuis InteliMonitor ou directement 
depuis la face avant du contrôleur. 

7. Sélectionner si la défaillance de la sonde sera évaluée. ‘Sensor Fail’ est une alarme 
qui apparaîtra si la valeur mesurée de l’entrée en particulier est en dehors de la plage 
de la sonde. Ce qui arrive si le câble de la sonde est coupé ou en court-circuit ou que 
la sonde elle-même est défaillante.  

NOTE:  

Cette option independante est disponible depuis la version du firmware 2.5 et supérieure. 
Dans les versions précédentes, l’option ‘Sensor Fail’ était automatiquement activée peut 
importe le type de protection qui était assignée à l’entrée. 
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NOTE:  

Cette fonctionnalité est prévue pour les entrées analogiques du calculateur moteur (ECU). 

ATTENTION!  
Il n’est pas recommandé de configurer une sonde analogique classique avec une protection et 
sans l’option de détection de défaillance de la sonde. 

 
Entrées analogiques ECU (calculateur moteur) 
La plupart des calculateurs fournissent des valeurs analogiques, qui peuvent être manipulées comme 
des entrées analogiques dans le contrôleur. Le sous branche ‘ECU’ apparaîtra dans la section ‘Analog 
inputs’ dans l’arborescence de gauche si un calculateur ECU est configurée. Cette sous branche 
contiendra un jeu d’entrées analogiques virtuelles. Ces entrées fonctionnent de la même manière que 
les entrées physiques à l’exception près qu’elles requièrent d’être assignées à une valeur source du 
calculateur EU avant de pouvoir configurer une fonction et/ou une protection. 
 

 CONFIGURATION DE LA VALEUR SOURCE D’UNE ENTREE ANALOGIQUE ECU 
 
La propriété supplémentaire (comparé à une entrée analogique classique) est la premère ligne 
appelée ‘ECU value’ dans la colonne centrale. Si vous cliquer sur celle-ci (2), vous pourrez voir la liste 
des valeurs sources disponibles fournies par le calculateur ECU en question. Il faut alors sélectionner 
l’une d’entre elle comme source pour l’affecter à l’entrée analogique en question (3). Cette affectation 
revient à connecter une sonde physique à une entrée analogique physique. Il est ensuite possible de 
configurer une fonction et/ou protection (4, 5) de la même manière que les entrées analogiques 
classiques. 
 
NOTE:  
L’essentiel de la configuration requise des entrées et sorties ECU est faite automatiquement quand le 
module ECU est configuré. Voir le sous châpitre ECU du chapitre modules.  
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Assistant de configurations des cylindres 
L’assistant facilite la configuration des entrées de mesure de température des cylindres. Cela aide à la 
configuration des mesures et des protections sur deux niveaux avec des consignes communes 
jusqu’à 32 sondes de température des cylindres. Aller dans l’onglet I/O, sélectionner une entrée 

analogique où le premier cylindre est connecté et cliquer sur le bouton  pour démarrer l’assistant. 

Sorties analogiques 
Une sortie analogique peut être utilisée pour piloter un panneau de mesures, pour une interface 
conventionnelle avec un haut niveau de contrôle et de surveillance du système ou pour l’envoie de 
données à des modules périphériques comme un ECU, un SHAOUT etc. Suivre les instructions ci-
dessous pour configurer une sortie analogique: 

 
ETAPES DE LA CONFIGURATION D’UNE SORTIE ANALOGIQUE 
 

1. Sélectionner la sortie analogique souhaitée. 
2. Sélectionner la valeur analogique qui sera envoyée à la sortie. 
3. Sélectionner la propriété CONVERT :  

• Yes – La valeur configurée sera transformée linéairement pour correspondre à la 
plage de sortie, par exemple 0mV – 10 000mV pour une sortie physique. La plage de 
sortie est 0 – 10 000mV même si en fait la sortie physique appropriée est de 0-20mA. 
Dans ce cas 10 000mV correspond à 20mA.  

• No – La valeur configurée sera envoyée directement à la sortie sans aucune 
transformation. La seule modification possible est sa ‘normalisation’ (normalize),c'est-
à-dire que le nombre de décimal est changé. Ce paramètre est en général utilisé pour 
les sorties ECU et SHAOUT.  

4. Si CONVERT est utilisé, cliquer sur le bouton... pour ouvrir le calculateur de limites qui est 
utilisé pour définir la fonction de transformation.  

5. Si CONVERT n’est pas utilisé, la propriété NORMALIZE peut être utilisé pour changer la 
résolution décimale de la valeur avant qu’elle soit envoyée à la sortie. Par exemple la valeur 
de tension du générateur, qui est de 230 dans le contrôleur, peut être envoyé sous la forme 
230.0 (2300).  

Sorties analogiques ECU 
Les sorties analogiques ECU sont utilisées pour envoyer des valeurs analogiques comme une 
demande de vitesse à un ECU. La configuration est similaire aux sorties analogiques mais avec 
comme différence :  

• La propriété CONVERT doit être définie à NO dans la plupart des cas.  
• Il y a une propriété supplémentaire ECU VALUE. Cliquer sur cette propriété pour sélectionner la 

valeur ECU où la sortie analogique sera dirigée. La liste des valeurs ECU disponible 
apparaîtra dans la colonne de droite après avoir cliqué la propriété ECU Value.  

 

Calculatrice des Limites 
La calculatrice est utilisée pour la définition de la fonction de transformation linéaire si CONVERT = 
YES. Entrer deux points de la valeur configurée et le niveau de sortie approprié pour chaque point. 
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TRANSFORMATION DE 0-150KW EN 0-10V SOIT 0-20MA 
 

 
TRANSFORMATION DE 0-150KW EN 4-20MA 
 
Exemples de configuration de sortie analogique 
EXEMPLE:  
La jauge analogique 0-20mA affiche la pression d’huile 0-6 Bar, donnée par une sortie analogie. La 
source de la valeur est configurée comme une entrée analogique "Oil press" et les limites sont fixées 
à 0 et 6.0 Bar, ce qui veut dire que la sortie analogique donnera 0mA pour une pression d’huile à 0 et 
20ma pour une pression à 6 Bars. 

CONFIGURATION 
PROPERTY VALUE 

SOURCE Pression d’huile (Oil Press) 

CONVERT OUI (Yes) 

LIMITS [0.0 ;0]..[6.0 ;10000] 
 
CALCULATEUR DES POINTS 
 SOURCE OUTPUT 

LOW 0.0 0 

HIGH 6.0 10000 
 

EXEMPLE:  
Interface analogique de la tension du groupe vers une PLC via un signal 4-20mA avec 4mA pour 0V 
et 20mA pour 300V. La valeur source est configurée avec la valeur ‘Gen V’ et les limites sont 0 ;2000 
et 300 ;10000, ce qui signifie que la sortie analogique donnera 4mA à 0V et 20ma à 300V. 

CONFIGURATION 
PROPERTY VALUE 

SOURCE Gen V 

CONVERT OUI (Yes) 

LIMITS [0 ;2000]..[300;10000] 
 
CALCULATEUR DES POINTS 
 SOURCE OUTPUT 

LOW 0 2000 

HIGH 300 10000 
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EXEMPLE:  
Contrôle du régime d’un moteur MTU via CAN. Dans ce cas, un module I-CB/MTU doit être configuré 
comme interface entre le contrôleur et l’unité de contrôle MTU type MDEC. L’I-CB demande à recevoir 
la demande de vitesse en RPM. 

NOTE:  
Comme la valeur source (SpeedReq RPM) à la même unité et la même résolution qui est exigée par 
la sortie analogique (1 RPM), il n’est pas nécessaire de la convertir ou de la normaliser.  
 
CONFIGURATION 
PROPERTY VALUE 

SOURCE SpeedReq RPM 

CONVERT No 

NORMALIZE No 
 
EXEMPLE:  
Contrôle du régime d’un moteur Volvo AUX via CAN J1939 (utilisation de la valeur APP de la trame 
proprietaire VP_AUX). La valeur APP de la trame VP_AUX  doit être comprise entre 0 et 100.0 %. 

NOTE:  
Comme la valeur source (Speed request) a la même unité et la même résolution exigée par la trame 
VP_AUX (0.1%), il n’est pas nécessaire de la convertir ou de la normaliser.  
 
CONFIGURATION 
PROPERTY VALUE 

SOURCE Requête de régime (Speed request) 

CONVERT No 

ECU VALUE Position pédale accélération (Accelerator Pedal Position) 

NORMALIZE No 
 
EXEMPLE:  
Contrôle du régime d’un moteur John Deere via le CAN J1939 (utilisant la trame TSC1). La trame 
TSC1 exige que la vitesse demandée soit exprimée en RPM. 

NOTE:  
Comme la valeur source (SpeedReq RPM) a la même unité et la même résolution qui est exigée par 
la trame TSC1 (1 RPM), il n’est pas nécessaire de la convertir ou de la normaliser.  
 
CONFIGURATION 
PROPERTY VALUE 

SOURCE Requête de régime (Speed request) 

CONVERT No 

ECU VALUE Position pédale accélération (Accelerator Pedal Position) 

NORMALIZE No 
 
 
NOTE:  
Voir le guide ComAp Electronic Engines Support pour plus de détails sur le contrôle de vitesse des 
moteurs via la gestion électronique ECU.  
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Calculatrice des Limites (classique) 
La calculatrice est utilisée pour la définition de la fonction de transformation linéaire si CONVERT = 
YES. Entrer deux points de la valeur configurée et le niveau de sortie approprié pour chaque point. 

NOTE:  
Il se peut que la colonne ‘Computed limites’ affiche l’information ‘N/A’ et que le bouton OK soit alors 
désactivé. Cela signifie que la transformation en question n’est pas autorisée ou possible.  
 

 

 
TRANSFORMATION DE 0-150KW EN 0-10V SOIT 0-20MA 
 

 
TRANSFORMATION DE 0-150KW EN 4-20MA 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

39 



 
 

 

Consignes de réglage 
ONGLET SETPOINTS 

Les ‘Setpoints’ sont les consignes de réglage du contrôleur qui sont utilisées pour régler le contrôleur 
en fonction des paramètres du groupe (comme par exemple les valeurs nominales ou des limites de 
production) et de modifier le comportement du contrôleur. 

GenConfig est utilisé pour écrire les valeurs initiales des points de consigne après programmation 
de la configuration. Les points de consigne sont alors modifiés en ligne avec le logiciel 
InteliMonitor ou directement depuis le panneau de commande du contrôleur. La reécriture de toutes 
les consignes après la programmation de la configuration peut être activée ou désactivée en cochant 
dans le menu l’option OPTIONS -> OVERWRITE SETPOINTS. 

Modification des consignes 
NOTE:  
Utiliser GenConfig pour modifier les consignes seulement si la configuration doit être modifiée en 
même temps. Si la configuration a déjà été finalisée et programmée dans le contrôleur, utiliser 
InteliMonitor ou le panneau avant du contrôleur pour réajuster les consignes nécessaires.  
 
NOTE:  
Comme GenConfig ne travaille pas en ligne avec le contrôleur, les changements de consigne 
n’affectent pas directement le contrôleur. Les changements sont pris en compte uniquement dans 
l’archive actuellement ouverte.  
 
Sélectionner l’onglet SETPOINTS pour modifier des consignes. Les consignes sont classées par groupe 
d’intérêt. Il existe différents types de consignes :  

• Nombres – cliquer sur la valeur d’une consigne et saisir la valeur au clavier numérique. La 
plage accordée par la consigne s’affiche sous forme d’une bulle lorsque le pointeur de la 
souris survole la zone en question.  

• Liste – cliquer sur la valeur d’une consigne et sélectionner votre choix à partir de la liste 
proposée.  

• Chaîne – cliquer sur la valeur d’une chaîne et saisir au clavier le texte souhaité.  
• Spécial – certaines consignes numériques ont des valeurs de limite qui s’affichent sous la 

forme d’un texte. En général pour la valeur 0 (zero) il sera affiché ‘OFF’ pour les quelques 
consignes qui ajustées à zéro désactive la fonction. Cliquer sur la valeur de la consigne et 
saisir au clavier numérique la valeur ou utiliser les flêches directionnelles haut et pas pour 
incrémenter/décrémenter la valeur de 1. La plage accordée par la consigne s’affiche sous 
forme d’une bulle lorsque le pointeur de la souris survole la zone en question. 
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Groupes d’accès et droits 
Chaque consigne peut avoir un niveau d’accès parmis 8.  

• Le groupe d’accès d’une consigne à 0 ne requière aucun mot de passe, les consignes sont 
alors modifiables sans aucune restriction. 

• Les groupes d’accès d’une consigne de 1 à 7 exigent que l’utilisateur ayant un accès à ce 
groupe s’identifie pour pouvoir modifier une consigne.  

 

EXEMPLE:  
L’image suivante montre comment restreindre toutes les consignes du groupe ProcessControl à 
l’exception de la consigne Base Load à un utilisateur ayant un niveau d’accès du niveau 1. La 
consigne base de charge (Base Load) sera du fait de son niveau 0 accessible sans avoir à saisir de 
mot de passe.  

Consigne fixe imposée 
par la version matérielle 
du contrôleur. 

Consigne avec un fond 
gris ne sera pas écrite 
par GenConfig. 

Modifier la valeur initiale 
de la consigne ici. 
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Huit différents utilisateurs peuvent être crée dans le contrôleur. L’utilisateur 0 est l’administrateur 
Administrator, qui a accès à tous les groupes sans aucune restriction. 

NOTE:  
Utiliser le logiciel InteliMonitor pour la gestion des utilisateurs d’un contrôleur et leur assigner des 
niveaux d’accès à chacun. 
 
NOTE:  
Le mot de passe par défaut d’usine pour chaque utilisateur est 0 (zero). 
 

Forcé la valeur d’une consigne 
Les consignes sont des données modifiables du contrôleur qui sont définies depuis le PC ou depuis le 
panneau avant du contrôleur. Ces données sont stockées en permanence dans la mémoire EEPROM 
du contrôleur. Cependant il est parfois nécessaire de forcer temporairement certains paramètres par 
l’activation d’une entrée binaire. 

EXEMPLE:  
La charge nominale d’un groupe est normalement ajustée pour refléter la puissance réelle du groupe, 
mais durant des journées d’été chaudes lorsque la température ambiante atteint un certain niveau la 
charge nominale doit être réduite pour prévenir de toute surchauffe. La fonction valeur forcée (force 
value) peut être utilisée pour résoudre cette contrainte.  
 
Suivre cette procédure pour configurer une fonction valeur forcée sur une consigne: 

1. Aller dans l’onglet SETPOINTS, sélectionner la consigne souhaitée et cliquer sur le bouton .... 
Si le bouton n’apparaît pas c’est que la consigne sélectionnée ne supporte pas cette fonction.  

2. Cliquer sur le bouton WIZARD en bas de la fenêtre valeur forcée.  
3. Entrer le nom de la valeur forcée par exemple "ReducedNominal". 
4. Sélectionner un objet binaire qui sera utilisé pour activer la valeur forcée. Cela peut être une 

entrée binaire physique (ex, dans le cas où la valeur forcée sera activée par un interrupteur 
sur l’armoire) ou une sortie binaire logique (ex, la sortie d’un bloc PLC). L’assistant configure 
automatiquement le LBI forcé avec l’entrée binaire sélectionnée. La configuration de l’entrée 
binaire logique peut ultérieurement est vérifiée ou modifiée dans l’onglet ‘LBI’.  

5. Sélectionner le type de la consigne qui sera utilisé pour définir la valeur alternative.  
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• Utiliser SELECT OTHER OBJECT dans le cas où vous souhaitez que la même valeur 
alternative serve à forcer d’autres consignes et que cette valeur a déjà été defini.  

• Utiliser USE DEFAULT SETPOINT pour créer une nouvelle consigne définissant la valeur 
qui remplacera la consigne d’origine.  

6. Si une nouvelle consigne est crée donner lui un nom reconnaissable (ex "Reduced Pnom") et 
définisser sa valeur initiale. 

NOTE:  
Il est possible de créer plusieurs valeurs de remplacement pour une consigne. La priorité d’une valeur 
de remplacement sur une autre est la même que celle affiché dans la fenêtre des valeurs forcées.  
 

 
FENETRE VALEUR FORCEE 
 

1. Nom de la consigne ciblée que la valeur de remplacement forcera  
2. Ligne 1 d’un élément forcé 
3. Ligne 2 d’un élément forcé 
4. Noms des consignes source pour definir les valeurs alternatives  
5. Valeur initale des consignes alternatives 
6. Noms des entrées logiques binaires qui sont utilisés pour activer les valeurs alternatives 
7. Boutons pour déplacer les lignes dans la liste. Si plusieurs valeurs sont actives en même, la 

valeur la plus haute remplacera la consigne. 

Horloges programmables 
Les holorges programmables sont des consignes particulières, situées dans un groupe distinct, qui 
contiennent des éléments ajustables et dépendent de l’horloge principale du contrôleur. Cliquer sur le 
bouton ... pour définir l’horloge programmable sélectionnée : 

NOTE:  
Il y a une sortie binaire logique (LBO) associée pour quatres horloges programmables. 
Les horloges programmables 1 à 4 affectent la sortie TimerAct 1-4, les horloges programmables 5 à 8 
affectent la sortie TimerAct 5-8, etc. 
 

1. Horloge programmable à l’arrêt 

 
L’HORLOGE PROGRAMMABLE EST A L’ARRET 
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2. Activation simple (une fois) 

Définir la date, l’heure et la durée (hh:mm) de l’horloge programmable. 

 
DEFINITION D’UNE HORLOGE UNIQUE 
 

3. Activation répétable 

Définir le type de la répétition:  

• Journalière 
• Hebdomadaire 
• Mensuel 
• Courte période (intervale) 

Les éléments à définir varient en fonction du style de répétition sélectionné. 

 
MODIFICATION DES PARAMETRES D’UNE REPETITION JOURNALIERE 
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Commandes 
ONGLET COMMANDES 

Les commandes sont utilisées par exemple pour démarrer ou arrêter à distance un moteur, pour 
contrôler à distance les contacteurs ou effacer les valeurs statistiques du contrôleur par le biais d’un 
protocole de communication (PC, MODBUS etc). Chaque commande appartient à l’un des huits 
groupes de niveau d’accès.  

• Les commandes appartenant au groupe 0 ne requierent pas de mot de passe, ils peuvent être 
utilisés sans aucune limitation. L’image ci-dessous montre la configuration où aucune 
identification/mot de passe n’est requis lors de la connexion au contrôleur pour commander à 
distance le moteur par exemple depuis le logiciel InteliMonitor.  

• Les commandes appartenants aux groupes de 1 à 7 imposent à l’utilisateur de s’identifier. 
L’image ci-dessous montre que seul un utilisateur avec un accès du niveau 7 pourra effectuer 
les autres commandes comme par exemple réinitialiser ou modifier les statistiques.  

Cliquer sur le niveau exigé d’une commande pour changer le niveau d’accès que l’utilisateur devra 
avoir pour utiliser la commande. 
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Protections analogiques universelles 
ONGLET PROTECTIONS 

En complément des protections des entrées analogiques il est possible d’attribuer une protection 
configurable pour chaque valeur analogique du contrôleur (ex, une valeur électrique calculée comme 
la puissance du générateur ou une sortie analogique d’un bloc PLC). 

Sélectionner l’onglet PROTECTIONS pour voir la liste des protections déjà assignées, en ajouter une ou 
en supprimer une. Les lignes en grise indiquent que ces protections des entrées analogiques ont été 
attribuées depuit l’onglet I/O. Il n’est pas possible de les supprimer ou modifier depuis cet onglet. Aller 
sur l’onglet I/O pour les modifier. 

 
LISTE DES PROTECTIONS DE L’ONGLET PROTECTIONS 
 

 
FENETRE DE CONFIGURATION D’UNE PROTECTION 
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Cliquer sur le bouton + et suivre les instructions suivantes pour assigner une protection à une valeur 
analogique :  

1. Commencer par sélectionner une valeur analogique pour laquelle une protection sera 
attribuée. 

2. Sélectionner le type de la protection. Noter qu’il s’agit d’une protection à un niveau donc une 
seule protection de la liste peut être sélectionnée. Pour avoir 2 niveaux de protection, vous 
devrez attribuer deux protections séparées avec un niveau différent pour la même valeur 
analogique.  

3. Sélectionner le groupe de consigne où les consignes de limites de protection apparaîtront. 
4. Sélectionner la période d’évaluation. Utiliser la période standard (100ms) pour toutes les 

protections à l’exception des protections critiques demandant une évaluation plus rapide. 
5. Sélectionner si la protection sera active lorsque la valeur analogique sera en dessous ou au 

dessous de la limte (+Fls activera la protection en cas de défaillance de la sonde). 
6. Sélectionenr comment la protection sera enregistrée dans le journal d’évènement (historique). 

ONCE signifie que seulement la première protection sera enregistrée jusqu’à l’appuie sur la 
touche Fault Reset, ALWAYS signifie qu’à chaque protection (même redondante) un 
évènement sera enregistré.  

7. Sélectionner si la limite sera une constante ou une valeur ajustable par une consigne. Si une 
consigne est utilisée, il est possible d’en créer une ou d’utiliser une consigne déjà existante. 
Partager une consigne pour plusieurs protections peut faciliter la configuration par exemple 
dans le cas de plusieurs sondes de température des échappements (gauche, droite) la 
consigne de protection serait la même. Si une nouvelle consigne, changer le nom de la 
consigne, ajuster sa plage et sa valeur initiale.  

8. Sélectionner le délai de la consigne ou constante. Procéder comme avec la consigne de 
limite. 

9. Sélectionner la période pendant laquelle la protection sera active. Les protections de certaines 
valeurs doivent être bloquées pendant que le moteur est à l’arret (protection pression d’huile).  

10. Sélectionner le message qui sera affiché dans la liste des alarmes ou dans l’historique quand 
la protection s’activera. Vous pouvez définir un nouveau message ou partager un même 
message avec d’autres protection(s). Il n’est pas possible de partager un message utilisé par 
une protection d’un niveau différent mais d’un type de protection différent.  

Types d’alarmes 

Type 
d’alarme/Evènement Niv. Description 

Warning 1 

L’alarme apparaît dans la liste des alarmes et est enregistré dans 
l’historique. 
Active la sortie Common Wrn ainsi que les sorties d’alarmes 
classiques. 

Alarm Only 1 
L’alarme apparaît seulement dans la liste des alarmes. 
Active la sortie Common Al ainsi que les sorties d’alarmes 
classiques. 

HistRecOnly 1 
L’évènement est enregistré dans l’historique 
Active la sortie Common Hst pendant une seconde. Les sorties 
d’alarmes classiques ne sont pas activées 

AL Indication 1 

L’évènement est seulement indiqué dans la liste des alarmes. 
Elle disparaît de la liste des alarmes automatiquement dès que la 
cause disparaît. 
Les sorties d’alarmes classiques ne sont pas activées 

A+H indication 1 

L’évènement est indiqué uniquement dans la liste des alarmes et 
enregistré dans l’historique. 
Elle disparaît automatiquement de la liste des alarmes dès que la 
cause disparaît. 
Les sorties d’alarmes classiques ne sont pas activées. 

Shutdown 2 

L’alarme apparaît dans la liste des alarmes et est enregistré dans 
l’historique. 
Elle entraîne l’arrêt immédiat du groupe sans transfert de charge ni 
phase de refroidissement. 
Le groupe ne peut pas être de nouveau démarré tant que le défaut 
‘shutdown’ est présent dans la liste des alarmes. 
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Active la sortie Common SD ainsi que les sorties d’alarmes 
classiques. 

Slow Stop 2 

L’alarme apparaît dans la liste des alarmes et est enregistré dans 
l’historique. 
Elle active la procédure standart d’arrêt du moteur  c'est-à-dire la 
séquence de transfert de charge et le refroidissement. 
Le groupe ne peut pas être redémarré tant qu’une alarme de ce 
type est dans la liste des alarmes. 
Active la sortie Common Stp ainsi que les sorties d’alarmes 
classiques. 

Off load 2 

L’évènement apparaît dans la liste des alarmes et est enregistré 
dans l’historique. Elle ne requière pas un acquittement et disparaît 
d’elle-même. 
Cela entraîne l’ouverture immédiat du débit groupe (GCB). Dans le 
mode AUT et SEM, le groupe reste en marche pendant 60 
secondes et il est ensuite arrêté par la séquence d’arrêt classique. 
Dans le mode MAN, le groupe reste en marche tant que 
l’opérateur n’intervient pas. 
Si le contrôleur est sur le mode AUTO ou SEM et que toutes les 
alarmes précédentes de ce type disparaissent, le groupe est 
automatiquement redémarré et reconnecté à la charge si les 
conditions de marche du groupe sont toujours actives (par ex. 
Rem Start/Stop est actif) 
Cet évènement est utilisé pour retirer le groupe temporairement de 
la charge pour n’importe quelle raison. 
Active la sortie Common OfL. 

Low Power 2 

L’évènement apparaît dans la liste des alarmes et est enregistré 
dans l’historique. Elle ne requière pas un acquittement et disparaît 
d’elle-même. 
Elle entraîne la réduction de la charge du groupe au niveau de la 
consigne MinPower PtM lors d’un fonctionnement en parallèle au 
réseau ou un fonctionnement en base de charge. Si toutes les 
alarmes de ce type disparaissent, le groupe reprend la charge 
suivant une rampe en fonction du mode de fonctionnement du 
contrôle de la charge active (Load Ctrl PtM) dans un 
fonctionnement en parallèle au réseau. 
Active la sortie Common LoP. 
Ce type d’alarme n’est pas inhibé par l’entrée Sd Override. 
Note : 
Uniquement valable sur les contrôleurs IS-NT 

BrkOpen&CoolDn 2 

L’évènement apparaît dans la liste des alarmes et est enregistré 
dans l’historique. Elle entraîne l’ouverture immédiat du débit 
groupe (GCB) sans transfert de charge et ensuite la séquence 
d’arrêt classique du groupe avec la phase de refroidissement. 
Le groupe ne peut pas être redémarré tant qu’une alarme de ce 
type (BOC) se trouve dans la liste des alarmes. 
Active la sortie Common BOC ainsi que les sorties d’alarmes 
classiques. 

Main Protect 2 

La protection est uniquement enregistrée dans l’historique. 
Dans les applications qui contrôlent le MCB (réseau), cette 
protection provoque l’ouverture du MCB. Le groupe peut continuer 
de fonctionner en îloté si c’est requis. Le MCB peut être refermé 
dès qu’il n’y a plus aucune protection de ce type (incluant les 
protections réseau internes) 
Dans une application qui ne contrôle pas le MCB, la protection 
provoque l’ouverture du GCB. Le contrôleur attend alors 
l’ouverture du MCB. Une fois ouvert, le groupe peut alors continuer 
de fonctionner en mode Iloté, si requis. Dès qu’il n’y a plus de 
protection réseau d’active (incluant les protections réseau interne), 
le GCB est ouvert une nouvelle fois et le contrôleur attend la 
fermeture du MCB. Le groupe peut alors continuer de fonctionner 
en parallèle au réseau si ce mode est requis. 
Active la sortie Common MP 
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Ce type d’alarme ne peut pas être inhibé par l’entrée Sd Override. 

Sd Override 2 

L’alarme apparaît dans la liste des alarmes et est enregistrée dans 
l’historique. 
Cela cause l’arrêt immédiat du groupe sans transfert de charge ni 
séquence de refroidissement. 
Le groupe ne peut pas être redémarré tant qu’une alarme de ce 
type est dans la liste des alarmes. 
Cette protection n’est pas inhibée par l’entrée Sd Override. 

 
EXEMPLE:  
Protection complexe – cet exemple montre comment utiliser les protections universelles pour créer 
une protection complexe d’une entrée analogique qui mesure la température de refroidissement. La 
protection activera une alarme d’alerte (warning) "Frost alert" chaque fois que la température est 
inférieur à 0° (limite fixé) ou une alarme appelé "Coolant Temp" de type alerte si la température est 
supérieur à 95°C (ajustable) avec un arrêt du moteur si elle atteint 100°C (ajustable). Le dépassement 
de la température devra se faire uniquement lorsque le moteur tourne.  

1. Aller dans l’onglet I/O et configurer une entrée analogique appropriée. Lui donner le nom 
« Coolant Temp », configurer le capteur adéquat et les autres éléments. Cocher la case 
‘Protection’ et configurer comme suite :  

• Protection type = cocher ‘Warning’ et ‘Shutdown’ 
• Active when = cocher ‘Over limit’ 
• History record = cocher ‘Always’ 
• Block type = cocher ‘RunOnlyBlkDel1’ 
• Ajuster les valeurs initiales des limites de consigne à 95 et  100° 

2. Aller dans l’onglet PROTECTIONS et cliquer sur le bouton + pour ajouter une protection.  
3. Sélectionenr la valeur Coolant Temp (précédemment crée) et configurer les propriétés comme 

ci-dessous :  
• Protection type = Warning 
• Protection group = Analog protect 
• Evaluation period = Standard 
• Active when = Under limit 
• Block type = All the time 
• History record = Always 
• Appuyer sur le bouton NEW MESSAGE et saisir le texte "Frost alert"  
• Sélectionner "Constant" pour la consigne de limite et de délais et les définir 

respectivement à 0 et à 10s 

 
EXEMPLE:  
Protection fenêtrée – cette exemple montre comment utiliser les protections universelles pour créer 
une protection fenêtrée pour la tension de la batterie. La protection indiquera une alarme d’alerte "Batt 
volt" chaque fois que la tension de la batterie sera inférieure à 18V ou supérieur à 30V.  

1. Aller dans l’onglet PROTECTIONS et cliquer sur le bouton +  pour ajouter une protection.  
2. Sélectionner la valeur UBat dans le groupe Analog CU et configurer les propriétés de la 

protection comme suite :  
• Protection type = Warning 
• Protection group = Analog protect 
• Evaluation period = Standard 
• Active when = Under limit  
• Block type = All the time 
• History record = Always 
• Appuyer sur le bouton NEW MESSAGE et entrer le texte "Batt Volt"  
• Sélectionner "New setpoint" pour la consigne de limite, donner lui le nom "Batt Volt <", 

définir la plage possible de la consigne entre 0 - 20V et définir la limite à 18V  
• Sélectionner "New setpoint" pour la consigne délais, donner lui le nom "Batt Volt Del" 

et définir le délai à 10s 
3. Cliquer sur le bouton + une nouvelle fois pour ajouter une nouvelle protection.  
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4. Sélectionner la valeur UBat value du groupe Analog CU et configurer les propriétés de la 
protection comme suite :  

• Protection type = Warning 
• Protection group = Analog protect 
• Evaluation period = Standard 
• Active when = Over limit  
• Block type = All the time 
• History record = Always 
• Message = "Batt Volt" 
• Sélectionner "New setpoint" pour la consigne de limite, donner lui le nom "Batt Volt >", 

définir la plage à 20 et 40V et définir la limite initiale à 30V  
• Sélectionner "Existing setpoint" pour la consigne de délai et sélectionner dans la liste 

la consigne "Batt Volt Del" précédement crée. 
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Historique 
ONGLET HISTORY 

Cet onglet est utilisé pour modifier le contenu du journal d’enregistrement de l’historique. Chaque 
enregisrement contient obligatoirement les colonnes date, heure et la cause de l’enregistrement. Le 
reste des colonnes est configurable. 

La structure d’un enregistrement d’évènement est composée de deux parties. La partie supérieure 
dite rapide ‘fast’ est écrite dans la mémoire immédiatement apres qu’un évènement se passe. Le 
reste de l’enregistrement est écrit dans un délai maximum de 100ms. La partie dite ‘fast’ est 
généralement utilisé pour des valeurs qui changent très rapidement comme par exemple les tensions, 
les courants et puissance. Les parties sont séparées par une ligne dans la liste contenant les valeurs 
à mémoriser  

 
 

1. Arborescence des valeurs disponibles 
2. Bouttons pour ajouter/supprimer les valeurs de la structure d’un enregistrement 
3. Bouttons pour réorganiser les valeurs dans la structure d’un enregistrement 
4. Séparateur ‘Fast’ de l’historique. La partie rapide est au dessus de ce séparateur 
5. Nombre d’enregistrement estimé dépendant de la taille d’un enregistrement 
6. Capacité utilisé d’un enregistrement 

NOTE:  
Il est recommendé de placer les valeurs qui sont affichées d’une couleur verte dans la partie rapide. 
 
NOTE:  
Si la case à cocher ADD MODULES TO HISTORY AUTOMATICALLY.. dans l’onglet Modules est cochée alors 
toutes les valeurs du module seront automatiquement ajoutées à l’enregistrement de l’historique 
lorsque qu’un module sera ajouté dans la configuration.  
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Sondes utilisateurs 
USER SENSORS 

Il est possible de créer une définition de sonde personnalisée si une sonde particulière n’est pas 
prédéfinie dans le firmware du contrôleur. Pour cela les caractéristiques de la sonde doivent être 
connues. La sonde personnalisée apparaîtra dans la liste des sondes qui s’affiche dans la section 
entrées analogiques de l’onglet I/O. 

Suivre cettte procédure pour créer une sonde spécifique utilisateur : 

 
 

 
 

1. Utiliser les boutons + et – pour ajouter ou retirer une sonde personnalisée.  
2. Sélectionner la configuration matériel (plage électrique). Le préfixe "CU" indique qu’il s’agit du 

configuration réservé au contrôleur principale. 
3. Donner un nom à la sonde. 
4. Sélectionner la résolution de la sortie, c'est-à-dire le nombre de décimal que la valeur 

convertie aura. 
5. Créer un nombre de points approprié aux caractéristiques de la sonde. 
6. Renseigner toutes les valeurs de chaque point, par exemple mA, V, Ohm etc. 
7. Renseigner toutes les valeurs de sortie de chaque point par exemple °C, Bar, kPa, % etc. 
8. Les points peuvent être chargés depuis un fichier *.crv depuis le disque ou sauvegardés dans 

un fichier. 
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La sonde personnalisée apparaîtra dans la liste des sondes qui s’affiche dans la section entrées 
analogiques de l’onglet I/O.  
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Langues et Traducteur 
Le contrôleur peut contenir des textes dans plusieurs langues. Le nombre de langue disponible qu’il 
est possible d’ajouter dépendra de la taille des textes utilisés dans la configuration (taille variable 
suivant la complexité d’une application, de la taille de ECU, du nombre de modules d’extension 
présents…). 

NOTE:  
L’emplacement de la langue n° 1 n’est pas modifiable et doit toujours contenir la langue anglaise. 
 
La procédure d’ajout d’une nouvelle langue se passe en deux étapes:  

1. Créer une nouvelle langue 
2. Traduire les textes 

 

Créer une langue 
ONGLET : LANGUES 

Création d’une langue : 

• Utiliser le bouton [ - ] pour effacer toutes les langues additionnelles inutiles. Si vous voulez 
créer une langue dite ‘graphique’ qui utilise de larges caractères (Korean, Chinese etc.), Ne 
pas effacer supprimer la langue existante utilisant de larges caractères avec le flag 
Unicode.  

• Cliquer sur le bouton [ + ] (1) pour créer un nouveau langage. Si vous voulez créer un langage 
latin, selectionner English comme langue de base. Si vous voulez créer un langage graphic, 
sélectionner la langue existante fondé sur des caractères graphiques comme par exemple 
Chinese ou "englishL" (2) comme langue de base.  

• Ensuite definir le nom de la langue crée (3), l’identifiant local (4) et le format de l’heure et la 
date (5). La zone Code page sera automatiquement renseignée après avoir sélectionné ID 
local dans la liste.  

• Dans le cas d’un langage graphique, vous pouvez maintenant supprimer le langage ayant 
servi de base. 

• Continuer sur l’onglet Translator pour traduire tout le text de l’anglais vers le langage de 
destination.  
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Transduction du texte 
ONGLET TRANSLATOR 

Juste après la création de la langue, tous les textes de la langue sont en anglais et doivent être 
traduit. 
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• Cliquer sur le bouton   (1) pour ouvrir un dictionnaire de travail(4). Une fenêtre avec une 
liste des dictionnaires s’ouvrira. Sélectionner votre dictionnaire ou cliquer sur le bouton [+] 
pour créer un nouveau dictionnaire. Les dictionnaires avec une icône grise (3) sont les 
dictionnaires de base et ne peuvent pas être sélectionné comme dictionnaire de travail. 
Utiliser le bouton USE DEFAULT ONLY pour appliquer la traduction avec le dictionnaire par 
défaut uniquement. Dans le cas, il n’est pas possible d’ajouter/modifier des textes traduits.  

NOTE:  
Pour éviter que les traductions personnalisées ne soient remplacé par de nouvelles version 
des dictionnaires par défaut, les traductions sont stockées dans un dictionnaire crée par 
l’utilisateur. Les dictionnaires par défaut, qui sont fournis avec le logiciel, sont en lecture seul 
et ne peuvent pas être utilisés comme dictionnaire personnalisé. La traduction se fait par une 
recherche dans le dictionnaire personnalisé, si la recherche n’aboutit pas alors le dictionnaire 
par défaut est utilisé.  

• Maintenant les élements non traduits (qui ne sont présents dans aucun dictionnaire) sont 
affichés avec une couleur bleu ciel (3), les éléments traduits par le dictionnaire de l’utilisateur 
sont en blanc (1) et les traductions par défaut (donné par le dictionnaire de base) sont en gris 
(2). Si un groupe contient au moins un text non traduit, son nom sera affiché en bleu ciel (4), 
si tous les éléments du groupe sont traduits, le groupe sera en gris ou blanc (5).  

NOTE:  
L’icône (6) indique que les textes du groupe en question sont utilisés sur l’affichage du 
contrôleur. Les groupes sans l’îcone contiennent des textes visibles uniquement depuis 
InteliMonitor/GenConfig. Dans certains cas, on gagne du temps à ne traduire que les textes 
qui n’apparaîtrons que sur le contrôle. 
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• Traduire les éléments non traduits en éditant directement dans la colonne de la langue 
appropriée. Les éléments modifiés sont ajoutés automatiquement au dictionnaire 
personnalisé. Faire le tout de tous les groupes de texte (sélectionner un groupe dans la partie 
gauche de la fenêtre)  

• En utilisant les icones dans la barre d’outils de l’onglet TRANSLATOR, vous pouvez marquer 
tous les textes ou juste un comme étant traduit si vous voulez garder sa version original. Il est 
également possible de revenir en arrière et de remplacer le texte traduit par le texte original.  
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Editeur de fonctions logiques programmables PLC 
L’éditeur PLC (PLC Editor) est un outil qui permet de vous aider à créer vos propres fonctions. Il est 
doté d’une interface graphique simplifiant son utilisation. 
 

 

 

Travailler avec l’éditeur 
Création d’une fonction logique programmable PLC 
NOTE:  
La liste des blocs PLC supportés va dépendre du type, firmware et précense d’un dongle du 
contrôleur. 
 
NOTE:  
Le Mode avancé doit être activé dans le programme pour rendre disponible l’éditeur PLC !  
 
Si l’archive ouverte be contient pas de programmation logique alors une zone de dessin vide est crée 
automatiquement quand on sélectionne l’onglet PLC EDITOR. Les différents étapes dans la création 
d’une fonction logique programmable PLC sont les suivantes :  

1. Définir les entrées et sorties de la fonction  
2. Ajouter plusieurs feuilles si nécessaire  
3. Ajouter les blocs PLC dans les feuilles  
4. Créer les connexions entre les entrées, blocs et sorties  
5. Ajuster les propriétés des blocs 
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ATTENTION!  
Veuillez toujours vérifier que les blocs sont ordonnés correctement, spécialement si vous utilisez des 
feedbacks directs des entrées et des sorties dans une feuille. Un mauvais ordonnancement des blocs 
peut entraîner des résultats incorrects !!!  
 
Ajouter une feuille 

Appuyer sur le bouton   dans la barre d’outils pour ajouter une nouvelle feuille à la fin de la zone 
de dessin (après la dernière feuille existante). Déplacer les bords de la feuille pour la redimensionner 
à votre convenance. 

 
REDIMENSIONNER LA FEUILLE 
 
NOTE:  
La fonction d’impression imprime chaque feuille de la zone de dessin sur une page. Les feuilles de 
grande taille sont redimensionné pour s’adapter à la page. Cela peut rendre la lecture de la page 
imprimée difficile.  
 
Effacer une feuille 

Appuyer sur le bouton   dans la barre d’outils pour effacer la feuille actuellement sélectionnée de 
la zone de dessin. 

Définir les entrées de la feuille 

 
ENTREES ET SORTIES D’UNE FEUILLE 
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Les entrées de la feuille sont situées sur le côté gauche de celle ci. Suivre les étapes suivantes pour 
ajouter ou éditer une entrée.  

1. Double-cliquer dans une case d’entrée libre pour ajouter une nouvelle entrée ou sur une 
entrée déjà existante pour  l’éditer. 

2. Sélectionner la source de l’entrée. Si une entrée binaire est crée, une source des catégories 
suivantes peut être sélectionnée :  

• BIN. VALUES – Cette catégorie contient toutes les valeurs binaires disponibles dans le 
contrôleur (entrées binaires, sorties binaires logiques etc.)  

• SHEET OUTPUTS – Cette catégorie contient toutes les sorties des feuilles PLC. Utiliser 
cette catégorie si une sortie provenant d’une autre feuille doit être utilisée.  

 

3. En créant une entrée analogique, la source peut venir des catégories suivantes :  
• ANA. VALUES – Cette catégorie contient toutes les valeurs analogiques disponibles 

dans le contrôleur (entrées analogiques, valeur électrique, valeurs de l’ECU, etc.  
• ALL SETPOINTS – Cette catégorie contient tous les points de consignes du contrôleur à 

l’exception des points de consignes PLC. Les noms, résolutions et unités de mesure 
ne peuvent pas être modifiés.  

• PLC SETPOINTS – Cette catégorie contient le groupe de points de consigne qui sont 
réservés à l’utilisation des fonctions logiques. Une consigne PLC peut être renommé 
(1) et la résolution (2) et unité de mesure (3) peut être modifié pour s’adapter aux 
blocs où ils seront utilisés.  

 
CONSIGNES PLC 

• SHEET OUTPUTS – Cette catégorie contient toutes les sorties des feuilles PLC. Utiliser 
cette catégorie si une sortie provenant d’une autre feuille doit être utilisée.  
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CATEGORIE DES ENTREES 

 
Définir les sorties de la feuille 

 
ENTREES ET SORTIES D’UNE FEUILLE 
 
Les sorties sont situées sur le côté droit d’une feuille. Double-cliquer sunr une case de sortie vide pour 
ajouter une nouvelle sortie. Sélectionner le type de la sortie (analogique ou binaire). Une nouvelle 
sortie est également crée automatiquement quand un fil est connecté d’un bloc de la feuille à une 
case vide en sortie. Double-cliquer sur une sortie déjà existante pour configurer la sortie sur une 
sortie du contrôleur ou une entrée logique binaire.  
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CONFIGURATION D’UNE SORTIE D’UNE FEUILLE 
 

• La sortie peut être renommée dans cette zone de saisie (1). 
• La liste (2) contient toutes les cibles sur lesquelle la sortie de la feuille est connectée.  
• Pour effacer une connexion existante, sélectionner la dans liste (2) et appuyer sur le bouton 

‘disconnect’ (4). 
• Pour ajouter une nouvelle connexion, sélectionner la destination dans la liste (5) et appuyer 

sur le bouton ‘Connect’ (3). La connexion apparaîtra dans la liste (2).  

 

Ajouter des blocs dans une feuille 

1. Sélectionner le bloc souhaité depuis l’arborescence de gauche et déplacer le vers la feuille. 
2. Double-cliquer sur le bloc pour ajuster ses propriétés. 
3. Connecter les entrées et sorties du bloc en traçant des liaisons dans la feuille. Pour connecter 

une entrée avec une entrée de la feuille, définir les entrées de la feuille en premier.  

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

62 



 
 

 

 
ADDING BLOCKS TO A SHEET 
 
Dessiner les liaisons 

1. Positionner la souris à l’emplacement où doit commencer la liaison (câble virtuel). Si l’espace 
sous le pointeur est un point de connexion, sa forme changera :  

2. Appuyer en le maintenant enfoncé le bouton gauche de la souris et déplacer le pointeur 
jusqu’à sa destination, le point de connexion sera marqué d’un cercle vert.  

3. Relacher le bouton gauche de la souris pour valider la connexion entre les deux points. Une 
liaison est automatiquement dessinée. 

 
INDICATION D’UN POINT DE CONNEXION VALIDE 
 

4. La liaison peut être éditée en déplaçant ses sections. La première section d’une liaison venant 
de la sortie d’un bloc ne peut pas être éditée. Une connexion directe entre la sortie et l’entrée 
d’un même bloc ne peut pas également être éditée.  
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EDITION DES LIAISONS 
 

Utilisation du presse-papiers 

• Sélection d’un élément : Cliquer sur un élement de la feuille pour le sélectionner. 
• Création d’une sélection multiple: Cliquer du bouton gauche dans un espace libre de la zone 

de dessin et déplacer le pointeur de la souris en maintenant le bouton gauche enfoncé pour 
sélectionner les éléments à inclure dans la sélection.  

 
 
Les opérations de presse-papiers et de sélection suivantes sont disponibles : 

 

   CTRL+X Couper une sélection 

   CTRL+C Copier une sélection 

   CTRL+V Coller depuis le presse-papiers 

   CTRL+A Sélectionner tout le contenu d’une feuille 

   ESC Annuler une sélection 

   DELETE Effacer une sélection 
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Exporter/importer des feuilles 

Appuyer sur le bouton   de la barre d’outils PLC pour sauvegarder la feuille sélectionnée dans un 

fichier. Appuyer sur le bouton   pour importer tous le contenu d’un fichier dans la feuille 
sélectionnée. La configuration des sorties d’une feuille n’est pas importée et devra être faite 
manuellement par la suite. 

NOTE:  
L’importation effacera tout le contenu actuelle de la feuille! 
 
ATTENTION!  
Veuillez toujours vérifier la configuration des entrées de la feuille, spécialement si vous importez une 
feuille qui a été crée avec une firmware ou une version de contrôleur différent.  
 
EXEMPLE:  
Cette fonction peut être utilisé lorsque la feuille contient une fonction PLC particulière qui sera 
régulièrement utilisée.  
 
Type des données PLC 
Les entrées et sorties binaires PLC peuvent avoir la valeur logique 0 (état inactif) ou 1 (état actif). Les 
entrées binaires d’une feuille peuvent être connectées à n’importe quelle valeur binaire du 
contrôleur aussi bien des entrées binaires physiques, logiques ou des sorties binaires d’autres blocs 
PLC. Les sorties binaires d’une feuille peuvent être reliées à des sorties physiques ou des entrées 
binaires logiques. 

Les entrées et sorties PLC Analogiques  sont des objets de type INTEGER16, ils peuvent avoir une 
valeur comprise entre -32767 et 32767. Les entrées analogiques des blocs PLC peuvent soit être des 
constantes soit être connectés à d’autres valeurs variables incluant les sorties d’autres blocs PLC ou 
points de consigne. Il y a un groupe dédié de point de consigne pouvant être utilisé. Le nom, unité et 
résolution peut être édité. 

NOTE:  
Il est bien sur possible de connecter une valeur de type de donnée différent à une entrée analogique 
d’une feuille. La fonction logique programmable PLC marchera correctement seulement si la valeur 
d’entrée est dans la plage d’un INTEGER16 (-32767 et +32767). Si par exemple une valeur de type 
UNSIGNED16 (de 0 à 65535) comme la tension de l’alternateur est utilisée, le bloc marchera 
correctement avec des valeurs entre 0 et 32767 mais des valeurs supérieurs seront interpretés 
comme négative.  
 
NOTE:  
Certains blocs PLC exigent d’avoir une source provenant d’une entrée analogique avec une certaine 
résolution et unité.  Par exemple le bloc Régulateur PID demande une source pour l’entrée "gain" 
avec la résolution et unité [0,01%]. Seuls les objets analogs avec la même résolution et unité peuvent 
être connectés à cette entrée.  
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Règles d’éxécution des fonctions PLC 
Les fonctions logiques programmables PLC sont exécutés toutes les 100ms. Les blocs sont exécutés 
dans l’ordre de la numérotation (numéro de l’élément), qui est indiqué dans chaque bloc. La 
numérotation des blocs est attribuée automatiquement selon le schéma suivant. 

 
SCHEMA DE L’ORDRE DES BLOCS 
 
ATTENTION!  
Veuillez toujours vérifier que les blocs sont ordonnés correctement, spécialement si vous utilisez des 
liaisons entre blocs d’une même feuille. Un mauvais ordonnancement peut entraîner des résultats 
incorrects!!!  
 

 
EXAMPLE D’ORDONNANCEMENT DE BLOCS 
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Barre d’outils de l’éditeur de PLC 

   

   Exporter la zone de dessin vers WMF 

   Restaurer la zone de dessin 

   Imprimer la zone de dessin 

   Couper la sélection 

   Copier la sélection 

   Coller depuis le presse-papiers 

   Sélectionner tout le contenu d’une feuille 

   Annuler la sélection 

   Effacer la sélection 

   Effacer tout le contenu d’une feuille 

   Rediriger les liaisons sélectionnées 

   Annuler la dernière modification 

   Rétablir la dernière modification 

   Afficher l’historique 

   Redessiner la zone de dessin 

   Afficher les informations PLC 

   Ajouter une nouvelle feuille 

 Affiche la fenêtre des consignes personnalisées 

   Importer la feuille depuis un fichier 

   Exporter la feuille  vers un fichier 

   Déplacer la feuille active vers le haut 

   Déplacer la feuille active vers le bas 

   Aller à la prochaine feuille 

   Aller à la feuille précédente 
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   Effacer la feuille active 

 
 

Blocs logique programmable 

• Logique AND/OR  
• Logique XOR/RS  
• Comparateur avec hystérésis  
• Comparateur différé 
• Comparateur fenêtré 
• Interrupteur analogique (relais) 
• Fonction mathématique I 
• Fonction mathématique athematical function II 
• Fonction mathématique AxB/C 
• Moyenne flottante 
• Moyenne flottante type ‘B’ 
• Fonction interpolation 
• Fonction interpolation type ‘B’ 
• Enregistrement historique forcé 
• Protection forcé (alarme) 
• Boucle PID avec sortie analogique 
• Boucle PID avec sortie analogique type ‘B’ 
• Boucle PID avec sortie analogique type ‘C’ 
• Boucle PID avec 2 sorties Monter/Descendre 
• Boucle PID avec 2 sorties Monter/Descendre type ‘B’ 
• Compteur impulsion 
• Horloge 
• Delais 
• Delais type ‘B’ 
• Rampe 
• Monter/Descendre 
• Incrémenter/Décrémenter 
• Décomposeur binaire 
• Constante analogique multiplexé 
• Saut 
• Convertir 
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Editeur d’écran intelivision 
ONGLET SCREEN EDITOR  

L’éditeur d’écran ‘Screen Editor’ est une fonction intégrée au logiciel GenConfig qui permet à 
l’utilisateur de modifier la présentation des écrans de mesure de l’intelivision 8 et/ou de l’intelivision 5. 
 
L’onglet Screen Editor n’est disponible qu’en mode avancé et uniquement à partir des archives IGS-
NT de version  2.6 ou supérieur. 
 
NOTE:  
Une aide indépendante de la partie Screen Editor est disponible dans le menu Help. 
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Entrées binaires logiques 
ONGLET LBI 

Les entrées logiques binaires (LBI) sont des entrées internes à la boucle de contrôle. La 
"Configuration" des LBI représente les connexions internes d’un objet source avec les entrées 
logiques binaires. Les objets Source peuvent être :  

• Entrées physiques ou virtuelles 
• Sortie logique binaire (sorties de la boucle du programme de contrôle) 
• Sorties PLC 

 

Si la source est une entrée physique ou virtuel alors la connexion de l’entrée vers le LBI est 
configurée comme une Fonction dans l’onglet I/O . Dans le cas où la source est une sortie PLC, la 
connexion de la sortie PLC à l’entrée binaire logique (LBI) est configurée dans l’éditeur PLC. 

L’onglet LBI est utilisé dans le cas où vous voulez créer une connexion qui boucle en interne (sortie 
logique interne vers une entrée logique interne). 

 
EXEMPLE CONFIGURATION LBI 
 
EXEMPLE:  
Le dessin montre comment basculer le contrôleur en mode OFF en utilisant une communication 
distante.  

1. Cliquer sur l’entrée binaire logique (LBI) ‘Remote OFF’  pour le sélectionner.  
2. Sélectionner la sortie logique binaire RemoteControl1 comme source. Cette sortie peut être 

controlée à distance via un protocole de communication (InteliMonitor, MODBUS..).  
3. La valeur peut être inversé avant d’agir sur l’entrée logique binaire (LBI). 

 
NOTE:  
Une entrée logique binaire ne peut avoir qu’une seule source. 
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Entrées logiques analogique 
ONGLET LAI 

Les entrées logiques analogiques (LAI) sont des entrées dans la boucle de contrôle du programme. 
La "Configuration" des LAI est le moyen interne de connecter des objets source avec des entrées 
logiques analogiques (LAI). Les objets source peuvent être :  

• Entrées physiques ou virtuelles analogiques 
• Sorties logiques analogiques (sorties dans la boucle du contrôle du programme) 
• Sorties PLC 

 

Si la source est une entrée physique ou virtuelle alors la connexion entre l’entrée et le LAI est 
configurée comme une fonctiondans l’onglet I/O. Dans le cas où la source est une sortie PLC, la 
connexion de la sortie PLC vers le LAI est configurée dans l’éditeur PLC (PLC editor). 

L’onglet LAI est utilisé dans le cas où l’on veut créer une connexion interne. 

 
LAI CONFIGURATION EXAMPLE 
 
EXAMPLE:  
Le dessin ci-dessus montre comment ajuster le niveau de la base de charge à distance (par exemple 
via le ModBus).  

1. Cliquer sur l’entrée logique analogique LdCtrl:AnExBld pour la sélectionner.  
2. Selectionner comme source la valeur analogique ExtValue. Cette valeur pourra être écrite à 

distance via un protocol de communication (e.g.MODBUS).  
3. Modifié la consigne Load ctrl PtM a ANEXT BASELOAD.  
4. Ecrite dans le registre ExtValue1 via MODBUS pour ajuster à distance la base de charge. 

Utiliser la  fonction Générer une image de la configuration pour exporter la table des registres 
MODBUS pour connaître les registres de cette archive particulière.  

 
NOTE:  
Une entrée logique analogique ne peut avoir qu’une seul et unique source. 
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Autres éléments de configurations 
ONGLET MISCELLANEOUS 

Cet onglet contient divers éléments de configuration qui n’appartiennet a aucun groupe de fonction ou 
de configuration. On pourrait nommer cet onglet comme ‘Divers’. 
 

• La liste déroulante (1) est utilisée pour sélectionner le format qui sera utilisé pour l’affichage 
de toutes les valeurs, consignes électriques (c'est-à-dire les mesures électriques, les valeurs 
calculées à partir de ces valeurs et les différentes consignes en rapport avec ces mesures). 
Toutes les valeurs et consignes affectées sont listées dans le tableau en dessous. 

 
• Le tableau (2) est utilisé pour renommer les valeurs Pulse counter 

 
• Le tableau (3) est utilisé pour renommer les ‘Remote Switches’ c'est-à-dire les sorties binaires 

logiques ‘Remote Switch’ de 1 à 8. Leurs textes sont alors utilisés pour afficher les 
interrupteurs virtuels dans la fenêtre Remote Switches du logiciel InteliMonitor. 

 
• Le tableau (4) est utilisé pour renommer les consignes Service Time. Le texte est affiché dans 

la fenêtre Values, groupe Statistics de la fenêtre Intelimonitor. 
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Table MODBUS personnalisée 
ONGLET MODBUS 

Cet onglet contient un utilitaire de configuration pour la personnalisation d’une table MODBUS. Avec 
cette utilitaire, il est possible de définir une table d’adresse spécifique. L’adressage Modbus d’origine 
reste inchangé et opérationnel. 
 

• Les boutons (1) sont utilisés pour ajouter ou supprimer une adresse spécifique de la table. 
Une nouvelle ligne est ajoutée en dessous de la ligne actuellement sélectionnée. Les 
adresses Modbus sont générées par pas de 1. Le nombre maximum d’adresse personnalisée 
est de 128. 
 

• Les boutons (2) sont utilisés pour sauvegarder/charger une table personnalisée Modbus 
 

• Les boutons (3) sont utilisés pour sélectionner l’objet de communication (valeur, consigne, 
état d’alarmes…) comme source de l’adresse Modbus de la liste. 

 
NOTE:  
Il est également possible de saisir directement une adresse dans le champ ‘Contr MODBUS’. Si 
l’adresse entrée n’existe pas dans la configuration actuelle, le champ Comm Object est affiché en 
rouge. 
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Menu description 

Menu File (fichier) 

Ouvrir une archive du disque 

Cliquer sur l’icône   ou sélectionner dans le menu FILE -> OPEN pour afficher la fenêtre de dialogue 
pour ouvrir une archive. 

Les archives par défaut sont situés dans le répertoire des documents partagés C:\Documents and 
Settings\All Users\Documents\ComAp PC Suite\GenConfig\Archives\Default 

Les archives crées par l’utilisateur sonThe user created archives sont généralement placées dans le 
répertoire de documents partagés : C:\Documents and Settings\All 
Users\Documents\ComAp PC Suite\GenConfig\Archives, mais ils peuvent être lu depuis 
n’importe quel répertoire, disque ou support. 

Sauvegarder une archive sur le disque 

Cliquer sur l’icône   ou sélectionner dans le menu FILE -> SAVE pour sauvegarder l’archive sur le 
disque. Si le nom du fichier n’a pas encore été attribué, celui-ci vous sera demandé sinon l’archive 
sera sauvegardé sous le nom de fichier attribué. 

Sélectionner dans le menu FILE -> SAVE AS pour sauvegarder l’archive sous un nom différent. 

Les options suivantes concernent la sauvegarde de l’archive:  

• Sauvegarder l’historique dans l’archive 
• Vérifier la cohésion avant de sauvegarder 

 

Recently saved archives (Archives récemment sauvegardées) 
Cet élément du menu  offre un moyen rapide d’ouvrir les archives qui ont été sauvegardées 
récemment. 

Close archive 

Cliquer sur l’icône   ou sélectionner dans le menu FILE -> CLOSE pour fermer l’archive actuelle. 

Lire une archive à partir du contrôleur 

Cliquer sur l’icône   ou sélectionner dans le menu FILE -> READ FROM CONTROLLER pour extraire 
l’archive depuis le contrôleur connecté. 

ATTENTION!  
S’assurer que les Paramètres de connexion sont correctement configurés avec d’extraire une archive. 
Une erreur de paramétrage peut vous amener à lire une archive d’un contrôleur non souhaité.  
 
NOTE:  
Si GenConfig a été lancé depuis InteliMonitor alors les paramètres de connexion sont configurés par 
InteliMonitor et l’archive est automatiquement extraite du contrôleur.  
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Ecrire la configuration vers le contrôleur 

Cliquer sur l’icône   ou sélectionner dans le menu FILE -> WRITE TO CONTROLLER pour écrire la 
configuration vers le contrôleur connecté. Administrator est affiché pour identification et completer 
l’opération. Les options suivantes influencent l’écriture de la configuration:  

• Remplacer les points de consignes 
• Effacer l’historique 

ATTENTION!  
S’assurer que les Paramètres de connexion sont correctement configurés avec d’extraire une archive. 
Une erreur de paramétrage peut vous amener à lire une archive d’un contrôleur non souhaité. Cette 
situation peut arriver spécialement dans le cas d’une connexion réseau.  
 
NOTE:  
Si GenConfig a été lancé depuis InteliMonitor alors les paramètres de connexion sont configurés par 
InteliMonitor ce qui ne requière plus une attention de l’utilisateur.  
 

Vérification de la cohésion 
Utiliser la fonction ‘Consistency check’ pour vérifier votre configuration. Cette fonction fait un rapport 
détaillé des éléments incorrectements configurés comme:  

• LBI/LAI doit été configurée mais aucune source 
• Miroir Alarme configuré incorrectement 
• Sonde utilisateur incorrectement définie 
• Version du fichier ESF ne correspond pas 
• .. et autres 

Vérification cohésion PLC 
La fonction ‘PLC Consistency check’ vérifie seulement la partie des fonctions logiques programmables 
de la configuration. Elle peut être utilisée durant la création des fonctions alors que le reste de la 
configuration n’est pas encore finalisé. 

Sélection de la langue de configuration 
Utiliser l’élément ‘Select configuration language’ du menu ‘File’ pour sélectionner la langue du 
contrôleur utilisée. Tous les noms des consignes, entrées, sorties etc apparaîtrons dans cette langue. 
Toutes les langues définies dans le contrôleur sont disponibles. 

NOTE:  
Cette option sélectionne uniquement la langue des textes du contrôleur. Les menus de Genconfig 
reste en anglais. 
 

Information sur le contrôleur et l’archive 
Utiliser ‘Controller/Archive info’ du menu ‘File’ pour avoir une information complète du contrôleur et de 
ces modules attachés. La fenêtre contient également Password decode number et serial number qui, 
envoyés ensemble à votre distributeur, permettent de retrouver le mot de passe du contrôleur. 

Exporter la configuration 
Utiliser la fonction ‘Configuration export’ du menu ‘File’ pour exporter la représentation de la 
configuration dans une table Microsoft Excel. La représentation contiendra les éléments suivants :  

• Entrées physiques et virtuelles 
• Sorties physiques et virtuelles 
• PLC 
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Importer la configuration 
Si vous voulez utiliser la configuration d’une archive qui n’est pas directement compatible avec le 
firmware actuel, la fonction ‘Configuration import’ doit être utilisée pour importer la configuration de 
l’archive original dans votre archive compatible avec votre firmware. 

1. Ouvrir l’archive cible par défault dans laquelle vous voulez importer la configuration. 
2. Sélectionner dans le menu FILE -> IMPORT CONFIGURATION WIZARD 
3. Sélectionner l’archive source et cliquer sur le bouton NEXT (suivant).  
4. La fenêtre suivante affiche les différences entre les deux configurations. Aucune modification 

n’est possible à ce stade. 
5. Appuyer sur le bouton NEXT pour executer l’importation.  
6. Quand l’importation est terminée, cliquer sur le bouton NEXT pour afficher la fenêtre rapport 

avec les résultats. Dans cette fenêtre, s’afficheront les alertes et erreurs qui sont apparues 
durant l’importation.  

7. Cliquer sur le bouton OK pour terminer l’importation.  

ATTENTION!  
Vérifier la nouvelle configuration, spécialement lorsque des alertes ou erreurs sont apparues. La 
configuration necessitera certaines corrections manuelles. Les corrections seront nécessaires si la 
configuration a été importée d’un firmware différent ou d’une application différente, par exemple 
certaines fonctions présentes dans le firmware source n’existent pas dans le firmware de destination.  
 
Vue d’ensemble des archives compatibles 
Archives compatibles:  

• Archives des différentes mises à jour d’un même firmware et d’une même version majeur et 
mineur (ex : IG-NT-2.3 x IG-NT-2.3.1 x IG-NT-2.3.2) 

Archives incompatibles:  

• Archives d’une version majeure ou mineure différente d’un même firmware (IG-NT-2.2 x IG-
NT-2.3) 

• Archives d’une branche de firmware différente 
• Archives de type de contrôleur différent (IG-NT x IS-NT) 

Image de la Configuration 
La fonction Configuration image - Comm. objects génère une table interne de la configuration du 
contrôleur contenant toutes les informations nécessaire à la programmation d’un client personnalisé 
sur la base du protocole de communication proprietaire ComAp. 

La fonction Configuration image - Modbus Registers génère la liste des toutes les variables et 
consignes internes du contrôleur qui contient toutes les informations nécessaire à la programmation 
d’un client personnalisé sur la base du protocole de communication MODBUS. 

NOTE:  
Plus d’information sur le protocol MODBUS sont disponible dans le guide ‘Inteli Communication 
Guide, qui peut être téléchargé sur le site www.comap.cz.  
 

Edition manuel de l’apparence de l’écran du contrôleur 
NOTE:  
Utiliser l’outil intuitif ScreenEditor pour l’édition des écrans de l’intelivision 8 et/ou de 
l’intelivision 5. Disponible à partir du firmware IG-NT-2.6/IS-NT-2.6/IM-NT 2.9 et supérieur.  
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L’apparence de l’affichage de l’écran du contrôleur est codée dans la configuration. Si il est 
nécessaire de modifier l’apparence par défaut des écran, le code peut être exporté dans un fichier 
XML, modifié puis réimporté. 

NOTE:  
Plus d’information sont disponible dans le guide Controllers Screens Editing Guide, qui peut être 
téléchargé sur le site www.comap.cz.  
 
Exportation de la description des écrans 
La fonction ‘Export screens’ du menu ‘File’ exporte le code d’affichage des écrans du contrôleur dans 
un fichier XML (*.ISC). 

NOTE:  
Finaliser toute la configuration avant d’éditer les écrans sous peine de perdre les modifications. 
Certaines parties du code de l’affichage (i.e. écrans des entrées analogiques des extensions) sont 
générées automatiquement quand une partie de la configuration est modifiée.  
 
Importation de la description des écrans 
La fonction ‘Import screens’ du menu ‘File’ importe le code d’affichage des écran à partir d’un fichier 
XML (*.ISC) dans la configuration. 

NOTE:  
Finaliser toute la configuration avant d’éditer les écrans sous peine de perdre les modifications. 
Certaines parties du code de l’affichage (i.e. écrans des entrées analogiques des extensions) sont 
générées automatiquement quand une partie de la configuration est modifiée.  
 

Mise à jour du Firmware du contrôleur 
Malgré que les contrôleurs soient toujours vendus avec la derniere version standard du firmware, il 
peut être nécessaire de procéder à une mise à jour dans certains cas. La personnalisation de certains 
firmwares exigents une reprogrammation du contrôleur. 

NOTE:  
Administrator est demandé pour identification pour programmer le firmware et/ou configurer le 
contrôleur.  
 
Importation de nouveau firmware 

• Aller dans le menu OPTIONS -> IMPORT FIRMWARE pour importer le nouveau firmware (obtenu 
par e-mail, depuis le site ComAp etc.) dans le logiciel GenConfig.  

• La fenêtre "Import firmware" apparaît. Cliquer l’icône   et sélectionner le fichier IGC que 
vous souhaitez importer.  

• Le contenu du fichier IGC s’affichera dans la partie inférieur de la fenêtre. 
• Cliquer sur le bouton "Import" pour confirmer l’importation du firmware. 
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Mise à jour Firmware (configuration par défaut) 
NOTE:  
La fonction ‘Firmware Upgrade (default configuration) permet la programmation du firmware des 
nouveaux contrôleurs ou la programmation d’une type différent de firmware. Pour mettre à jour le 
firmware d’une même branche d’un contrôleur déjà configuré, utiliser la fonction Firmware upgrade 
(existing configuration) . 
 
La fonction FIRMWARE UPGRADE (DEFAULT CONFIGURATION) implantera le firmware sélectionné dans le 
contrôleur. Apres la programmation, le contrôleur contiendra l’archive par défaut (application SPtM 
dans le cas de la gamme standart) qui doit être modifié pour correspondre à l’application requise. Voir 
le chapitre Configuration du contrôleur pour connaître comment modifier la configuration. 
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Sélectionner le firmware requis à partir de la liste et appuyez sur le bouton OK. Si le firmware requis 
n’apparaît pas dans la liste, importer le en premier. 

ATTENTION!  
Ne programmer pas un contrôleur IG-NT avec un firmware pour IS-NT et inversement ! 
 
Mise à jour du Firmware (configuration existante) 
NOTE:  
La fonction ‘Firmware upgrade (existing configuration)’ est destiné pour la mise à jour du firmware 
d’un contrôleur déjà opérationnel. Pour planter le firmware dans un nouveau contrôleur ou implanter 
un autre type de firmware, utiliser la fonction Firmware upgrade (default configuration) function.  
 
Cette fonction effectue automatiquement les opérations suivantes :  

1. L’archive est extraite du contrôleur et sauvegardée dans un fichier. 
2. Une fenêtre avec les firmwares disponibles et les archives par défaut est affichée. Le nouveau 

firmware requis doit être sélectionnée à partir de cette fenêtre et si le nouveau firmware n’est 
pas compatible avec l’archive orginal du contrôleur alors une archive par défaut pour importer 
la configuration doit être sélectionnée.  

 
INCOMPATIBLE FIRMWARE SELECTED 
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FIRMWARE COMPATIBLE SELECTIONNE 
 

3. Si le nouveau firmware n’est pas compatible avec l’archive original alors l’importation de la  
configuration original dans la configuration par défaut du nouveau firmware se fera 
automatiquement.  

4. Le firmware sélectionné est implanté dans le contrôleur. 
5. La configuration est implantée dans le contrôleur. 
6. Les Consignes de l’archive sont écrites dans le contrôleur.  

 

NOTE:  
Cette fonction devrait réduire les efforts nécessaires à la mise en place d’un nouveau firmware d’un 
contrôleur déjà installé et utilisé sur un site. Attention cependant, les nouveaux firmwares peuvent 
apporter de nouvelles fonctionnalités ou modification de fonctionnement qui requière une attention 
particulière. Veuillez toujours lire avec attention le document ‘Nouvelles fonctionnalités’ du 
firmware (document ‘New Features’). 
 
Clonage 
Utiliser la fonction de clonage pour créer une copie identique d’un contrôleur. La fonction peut vous 
aider dans les situations suivantes :  

• Remplacement d’un contrôleur d’effectue par un autre sur un site. 
• Production de plusieurs groupes identiques. 

 

La procédure se passe 2 étapes qui sont les suivantes :  

1. Sauvegarde pour clonage ultérieur 
2. Création du clone 

Contenus du clone:  

• Descriptif du fichier Clone  
• Archive du contrôleur 
• Firmware du contrôleur correspondant à l’archive 
• Firmwares des afficheurs externes (optionel, pour les terminaux connectés via la borne 

RS485 dédiée) 
• Police graphique (optionel, seulement pour les contrôleurs/terminaux qui supportent les 

polices graphiques) 
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Sauvegarder pour clonage ultérieur 
La fonction SAVE FOR LATER CLONNING (CONTROLLER ONLY) sauvegardera la configuration actuellement 
ouverte depuis le disque ou par extraction du contrôleur. Cette option ne sauvegarde pas les 
firmwares des terminaux externes et les polices graphiques dans le fichier Clone. 

La fonction SAVE FOR LATER CLONNING (CONTROLLER AND DISPLAYS) se connecte automatiquement au 
contrôleur, lit la configuration depuis celui-ci et le sauvegarde comme clone. Les firmwares des 
terminaux externes connectés via le bus dédié RS485 et les polices graphiques sont sauvegardées en 
meme temps dans le clone généré. 

NOTE:  
Si vous avez un message d’erreur "Firmware XXXX was not found" lors de l’ouverture de la fenêtre 
"Save clone", cela veut dire que vous ne disposez pas du firmware présent dans le contrôleur sur le 
disque et que le clone ne peut être généré. Dans ce cas, il faut au préalable importer le firmware dans 
le logiciel GenConfig.  
 
Créer un clone 
Utiliser la fonction CREATE CLONE... pour faire du contrôleur actuellement connecté une copie parfaite 
du contrôleur original ayant servi à créer le clone (firmware, configuration, consignes, fonts..). L’utilité 
de cette fonction à pour objectif de créer une sauvegarde complète du site dans le cas où le 
contrôleur ou terminal devrait être emplacé ou en préparation de plusieurs contrôleurs identiques. 

1. Connecter le contrôleur cible (avec les afficheurs si nécessaire) au PC. 
2. Démarrer le logiciel GenConfig et modifier les paramètres de connexion en conséquence.  
3. Aller dans le menu FILE -> CREATE CLONE... et sélectionner le clone requis.  
4. Appuyer sur le bouton OK pour implanter le clone sélectionné dans le contrôleur.  

Importer/Exporter un clone 

Appuyer sur le bouton   pour exporter le clone sélectionné dans un fichier dans le but d’être 
archivé, envoyé par email etc. 

Appuyer sur le bouton   pour importer un clone sauvegardé précedemment dans le logiciel 
GenConfig. 

Programmation du firmware d’un contrôleur ne répondant plus 
Si le contrôleur ne contient pas un firmware valid, un nouveau firmware ne peut être implanté par la 
voix standard. Cette situation peut survenir lorsque la connexion entre le PC et le contrôleur est 
interrompu pendant une mise à jour du firmware par exemple. Dans ce cas, le contrôleur afficher un 
écran vide et ne communique plus avec le PC. Le cavalier de boot (boot-jumper) doit être utilisé pour 
implanter un firmware valid dans le contrôleur. 

1. Déconnecter l’alimentation du contrôleur et mettre le cavalier ‘boot’ en position fermé. Voir le 
manuel du contrôleur pour plus de détail sur la localisation du cavalier.  

2. Connecter un cable de communication (en accord avec le type du contrôleur utilisé) entre le 
contrôleur et l’ordinateur. 

3. Selectionner une connexion direct avec comme adresse de contrôleur ‘1’. 
4. Aller dans le menu CONTROLLER -> PROGRAMMING AND CLONNING -> FIRMWARE UPGRADE,  

sélectionner le firmware approprié et cliquer sur le bouton OK.  
5. Suivre les instructions données à l’écran (une fenêtre s’affiche) et appuyer sur le bouton OK.  
6. Un autre message apparaîtra lorsque la programmation sera terminée. Suivre les instructions 

données. 
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Afficher la mise à jour du firmware upgrade et changement de police 
Utiliser cet élément pour mettre à jour le firmware ou pour changer la police dans un module externe 
IS-Display ou IG-Display qui est connecté via le bus RS485. 

NOTE:  
Utiliser INTELIVISION FW UPGRADE pour mettre un jour le firmware du module InteliVison.  
 
NOTE:  
L’affichage interne IG-NT ne supporte pas cette mise à jour du firmware. 
 

 
 

 
 

 

1. Liste de tous les afficheurs reliés (excepté l’InteliVision 8) 
2. Liste de toutes les polices disponibles sur le disque 
3. Liste des firmwares disponible sur le disque pour le type d’afficheur sélectionné (1) 
4. Appuyer sur le bouton RETRY pour rafraichir la liste des afficheurs connectés (dans le cas où 

un afficheur externe a été mis sous tension après la lecture de la configuration).  
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5. Appuyer sur le bouton WRITE TO DISPLAY pour écrire le firmware sélectionné ou la police 
sélectionnée dans l’afficheur sélectionné.  

NOTE:  
Les nouveaux firmwares et polices peut être importé dans GenConfig avec les firmwares du 
contrôleur.  
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Menu Options 

Options => settings (Option => Paramètres) 
Donne accès à divers paramètres du programme: 

 
 

1. Sélectionner le mode du programme par défaut.   
2. Sélectionner le langage de prédilection qui sera utilisé (en quelle langue seront affichés les 

textes pour la configuration). Si la configuration contient la langue sélectionnée, Genconfig 
l’utilisera automatiquement sinon le texte apparaîtra par défaut en anglais.  

3. Cocher cette case si vous voulez que la fenêtre des consignes (Setpoint) n’affiche que les 
objets concernées. Cette option masque toutes les consignes qui ne sont pas applicable avec 
la version matériel du contrôleur sélectionnée. 

4. Selectionner comment les compteurs des statistiques seront repris par la fonction du clonage 
(cloning). Les compteurs ddu contrôleur de destination peuvent être conservés, effacés ou 
réinitialisé avec les valeurs contenus par la configuration du clone sauvegardé.  

NOTE:  

Si vous remplacé un contrôleur par un autre, alors l’option ‘copy’ devrait être utilisé pour 
reprendre les compteurs statistiques au lieu de repartir de zéro.  

 

5. En cochant cette option, la date et l’heure du contrôleur seront mises à jour par le programme 
Genconfig durant la phase du clonage par rapport à l’horloge de l’ordinateur.  

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

84 



 
 

 

Configuration de la connexion 
NOTE:  
Si GenConfig a été lancé depuis le logiciel InteliMonitor, les paramètres de connexion seront calqués 
sur les paramètres d’InteliMonitor et les utilisateurs n’ont pas à s’en soucier.  
 
Configuration connexion Direct 
Sélectionner le port COM sur lequel est connecté le contrôleur et indiquer l’adresse correcte du 
contrôleur. 

 
FENETRE CONFIGURATION CONNEXION DIRECT 
 
NOTE:  
Le port COM peut être un port physique (ex une carte RS232 ou RS485 installé dans l’ordinateur) ou 
un port virtuel. Les ports COM virtuels sont créés en général par les pilotes des cables convertisseur 
USB/RS232 ou le pilote du port USB pour le module IGS-NT E-COM.  
 
ATTENTION!  
Ne pas déconnecter un device USB en cours d’utilisation! 
 

 
SCHEMA DU CABLE SERIE RS232 
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Configuration Connexion Modem 

1. Selectionner le modem qui sera utilisé pour la connexion. Le modem doit être correctement 
déclaré sur l’ordinateur avant d’être utilisé par GenConfig. Utiliser le cdrom d’installation fourni 
du modem pour l’installer sur l’ordinateur.  

NOTE:  
Utiliser un modem compatible avec le modem installé du coté du contrôleur. Des risques 
d’incompatibilité peuvent apparaître entre un modem GSM et un modem Anagique.  
 
NOTE:  
Veuillez prendre en considération que les modems GSM fournissent une connexion 
relativement lente et les opérations d’écriture et de lecture peuvent prendre plusieurs minutes. 
 

2. Entrer le numéro de téléphone de la ligne du contrôleur. Utiliser le format propre à votre 
système téléphonique local. 

3. Sélectionner l’adresse du contrôleur et entrer le code d’accès. 

 
FENETRE DE CONFIGURATION CONNEXION MODEM 
 
ATTENTION!  
La programmation du firmware par modem est déconseillée. La perte de connexion durant cette 
phase mettrait le contrôleur hors service. Il faudra alors se connecter via un cable en mode Bootload 
pour reprogrammer le contrôleur.  
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Configuration connexion Ethernet/Internet 

1. Saisir l’adresse IP attribué au contrôleur. Saisir une adresse IP locale pour un réseau LAN 
interne. Si le contrôleur est connecté sur un réseau externe, une adresse IP public doit être 
entrée. La passerelle ou proxy doit permettre le traffic des données à travers le port 23 vers le 
contrôleur.  

2. Selectionner l’adresser du contrôleur et saisir le code d’accès. 

 
FENETRE DE LA CONFIGURATION D’UNE CONNEXION ETHERNET  
 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

87 



 
 

 

Configuration connexion AirGate 

1. Saisir l’adresse du serveur AirGate. (airgate.comap.cz pour le serveur européen). Vous 
pouvez saisir l’adresse sous la forme de nom de domaine ou sous la forme d’une adresse IP.  

NOTE:  
Il existe un serveur public gratuit : airgate.comap.cz.  

2. Renseigner le champ ‘AirGate ID’, identifiant qui a été attribué par le serveur au contrôleur 
lorsque celui-ci s’est déclaré sur le serveur la premiere fois. Cet identifiant est unique et sera 
toujours le même. 

3. Renseigner l’adresse du contrôleur et le code d’accès. 

 
FENETRE DE LA CONFIGURATION D’UNE CONNEXION AIRGATE 
 

Option Consignes remplacées 
Si cette option ‘Ovewrite Setpoints’ est cochée, les consignes contenues dans l’archive seront 
toujours réécrite en même temps que la configuration. Les valeurs des points de consigne du 
contrôleur seront remplacés par les valeurs contenues dans l’archive. 

NOTE:  
Si cette option est cochée et que GenConfig a été lancé depuis InteliMonitor, alors tous les 
changements effectués depuis InteliMonitor, alors que Genconfig tournait en arriere plan, seront perdu 
si la configuration est écrite sur le contrôleur !  
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Option Effacer l’historique 
Si cette option ‘Clear History’ est cochée alors les données des évènements (historique) contenu dans 
le contrôleur seront toujours effacées après l’écriture de la configuration. 

Réinitialiser depuis l’etat Init 
Si le contrôleur détecte, apres redémarrage, que les consignes ne sont pas correctes (ex : la somme 
de contrôle ne correspond pas), l’application n’est pas démarré et le contrôleur reste à l’état ‘Init’ pour 
prévenir d’un disfonctionnement du fait de fausses consignes. Ce cas se présente régulièrement 
après programmation d’un nouveau firmware dans le contrôleur. 

Si l’option ‘Reset from Init’ est coché, GenConfig réinitialisera automatiquement le contrôleur après 
configuration ou programmation du firmware. 

Sauvegarder l’historique dans l’archive 
Cocher cette option ‘Save history to archive’ du menu si vous voulez que GenConfig sauvegarde 
toujours une archive complète incluant l’historique (comme sous InteliMonitor). Cette option augmente 
le temps nécessaire à la sauvegarde de l’archive (du fait que GenConfig doit extraire toute l’historique 
du contrôleur avant de le sauvegarder..), de plus il pourra y avoir des confusions entre les archives qui 
contiennent un historique et ce n’en contenant pas. 

Vérification de la cohésion avant sauvegarde 
Si cette option ‘Check consistency before save’ est cochée, une vérification de la cohésion de la 
configuration est automatiquement effectuée avant la sauvegarde de l’archive. La vérification est juste 
à titre informative et ne bloque pas l’opération de sauvegarde. 

Importer un firmware 
Voir le chapitre Mise à jour du Firmware. 

Gestionnaire de dictionnaire 
Cette option ‘Dictionary manager’ est destinée à la manipulation des dictionnaires. Pour obtenir plus 
d’information sur les dictionnaires et le choix des langues, se reporter au chapitre Langages et 
Traduction. 

 
 

1. Créer un nouveau dictionnaire personnalisé 
2. Effacer un dictionnaire personnalisé sélectionné 
3. Renommer le dictionnaire sélectionné 
4. Exporter le dictionnaire sélectionné (le sauvegarder sous un autre nom à un autre endroit) 
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5. Importer le dictionnaire (copier le dictionnaire d’un support vers le répertoire des dictionnaires 
de GenConfig) 

6. Afficher le contenu (paire de mots) du dictionnaire sélectionné 
7. Dictionnaire par défaut est représenté par un icône gris 
8. Dictionnaire personnalisé est représenté par un icône bleu 

List ECU 
ECU list est un fichier avec l’extension ESL qui contient la liste des moteurs EFI et liens vers les 
fichiers descriptifs (Fichiers ESF). La liste ECU est installée avec le programme GenConfig et est 
toujours mise à jour lorsqu’un nouveau firmware d’un contrôleur est importé. 

La liste actuelle des ECU est également indiquée dans le nœud "ECU" dans l’arborescence de 
gauche de l’onglet Modules. 

Utiliser toujours ECU List - Gensets excepté si un firmware personnalisé est utilisé requierant une 
liste ECU différente. 

 
 

Liste ECU 
actuellement utilisée 
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Serveur DDE  
Le Serveur DDE est l’interface de communication entre le PC et le contrôleur. Il est automatiquement 
démarré à la demande du programme principale, lors d’écriture ou de lecture d’une configuration vers 
le /du contrôleur. Utiliser la combinaison de touches ALT-TAB (basculement de tache window) pour 
afficher la fenêtre du ServeurDDE.  

• Cliquer sur le bouton LAST ERRORS pour voir les derniers messages d’erreur.  
• Cliquer sur le bouton STOP pour mettre en pause la communication (ne ferme pas la 

connexion).  

 

 
 
ATTENTION!  
Le serveur DDE est démarré et fermé automatiquement. Ne pas le fermer manuellement! 
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Status du serveur DDE 
Le status (Running / Preparing / Error) de chaque contrôleur est visible depuis la fenêtre du serveur 
DDE. 

STATUS COULEUR SIGNIFICATION 

Running Vert La connexion est active, aucun problème rencontré 

Programming Bleu 
Le serveur DDE est en train de programmer ou configurer le 
contrôleur. La progression est affiché en pourcentage dans la barre de 
status.  

Preparing Jaune 

Le serveur DDE est en train d’établir une connexion avec le contrôleur. 
Ce status peut apparaître prendant quelques secondes ou plusieurs 
minutes en fonction du type de connexion et du nombres de 
contrôleurs connectés.  

Error Rouge 

Echec de la connexion. Utiliser les touches ALT-TAB, sélectionner le 
serveur DDE et cliquer sur le bouton "Last errors" de l’adresse du 
contrôleur concernée pour avoir plus d’information sur la raison de 
l’échec  

 

Messages d’erreur du serveur DDE 
 

Timeout 
(continuous) 

Le contrôleur ‘supposé’ connecté ne répond pas aux demandes du 
serveur DDE dans un délai imparti. 
Raisons probables:  

• Le contrôleur n’est pas connecté correctement ou il est hors 
tension 

• Le cable de communication est endommagé ou incorrect 
• Le bon port du communication COM n’est pas correctement 

sélectionné (attention certains cables convertisseurs peuvent 
présenter des problèmes de fiabilité) 

• La consigne relatif au mode de communication dans le contrôleur 
n’est pas correctement ajusté (DIRECT par default) 

• Le processus de communication du contrôleur est endommagé 

Timeout (time to 
time) 

Une surcharge du système d’exploitation peut entrainer 
occasionnellement une perte ponctuelle de communication 

TAPI: requested 
modem (#) not found 

Le modem sélectionné n’a pas été installé correctement ou connecté 
(Lors d’une premiere installation d’un modem, le système peut nécessiter 
un redémarrage pour finaliser correctement son installation) 

TAPI: unavailable 
modem 

Le port de communication est actuellement utilisé par un autre 
programme ou processus.  

TAPI: Line 
unexpectedly closed 

Le Modem est déclaré dans Windows, mais il n’est pas connecté, sous 
tension ou défaillant.  

TAPI: Can't create 
connection 

Il n’est pas possible d’ouvrir une connexion. 
Raisons probables :  

• Le modem essaye de se synchroniser avec l’autre modem sans 
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succes. Soit la qualité de la ligne est mauvaise soit les modems 
sont incompatibles.  

• La ligne destinataire est occupée. 
• Aucune tonalité, la ligne du modem n’est pas connecté, 

branchement non standard, norme de la ligne inadaptée au 
modem (ISDN) 

Fenetre Pop-up avec 
le message Can't 
open COM 

Le port de communication COMxx est utilisé par un autre programme ou 
non installé (car de cable convertisseur USB qui change parfois 
d’identifiant). Fermer les autres programmes succeptibles d’utiliser ce port 
de communication ou essayer avec le bon port de communication  
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Annexe 

Fonctions de la barre d’outils PLC 
Exportation de la zone de dessin vers une image 

Appuyer sur le bouton   de la barre d’outils PLC pour exporter toute la zone de dessin (tous les 
feuilles) vers un fichier au format window metafile (WMF). Le WMF est un format de dessin vectoriel 
qui peut être lu et édité par la plupart des logiciels de dessins vectoriels comme CAD editors, 
Microsoft Visio etc.. 

 

Restaurer la zone de dessin 
Le programme crée automatiquement un copie de la zone de dessin. Si vous fermez accidentellement 

le programme, Appuyer sur le bouton   de la barre d’outils PLC pour selectionner la copie de 
sauvegarde que devra être restaurer. Les copies de sauvegarde sont générées automatiquement 
avec un nom de fichier contenant la date et l’heure de la sauvegarde suivant le format 
"yyyy_mm_dd_hh_mm_ss_xxxx.xml" 

ATTENTION!  
Si vous ouvrez une sauvegarde qui a été faite avec une version différente du firmware ou avec une 
version différente du contrôleur, la configuration des entrées et sorties des feuilles restaurées peuvent 
être incorrectes !!  
 

Imprimer la zone de dessin 

Cliquer sur l’icone   pour imprimer toute la zone de dessin. Après avoir cliquer, une fenêtre avec 
un aperçu est ouverte, où le résultat qui sera obtenu peut être prévisualisé. Cliquer sur le bouton 
PRINT pour ouvrir la fenêtre standart d’impression. 

NOTE:  
Chaque feuille PLC est imprimée sur deux pages. La premiere page contient la représentation 
graphique de la feuille et la seconde page (ou plus) contient la description sous forme de table. Le 
graphique est toujours zoomé pour s’adapter à la taille de la page.  
 

Couper la sélection 

Utiliser le bouton   ou les touches [CTRL]+[X] pour couper la sélection actuelle de la feuille dans 
le presse-papiers. 

 

Copier la sélection 

Utiliser le bouton  ou les touches [ CTRL ]+[C] pour copier la sélection actuelle de la feuille dans 
le presse-papiers. 

 

Coller à partir du presse-papier 

Utiliser le bouton   ou les touches [CTRL]+[V] pour coller le contenu du presse-papiers dans la 
feuille active. 

NOTE:  
Le presse-papier est vidé apres que le contenu ait été copié dans une feuille. 
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Sélectionner tout le contenu 

Utiliser le bouton   pour sélectionner tout le contenu de la feuille active. 

 

Déselectionner 

Utiliser le bouton   pour désélectionner le ou les objets sélectionnés. 

 

Effacer la sélection 

Utiliser le bouton   pour effacer la sélection actuelle. 

 

Vider une feuille 

Utiliser le bouton   pour effacer tout le contenu de la feuille active. 

 

Rediriger un/des cable(s) sélectionné(s) 

  (non implémanté dans la version actuel) 

 

Annuler le dernier changement 

Utiliser le bouton   ou la combinaison de touche [ CTRL+Z ] pour annuler le dernier changement 
apporté. 

 

Annuler la derniere annulation 
Utiliser le bouton   pour annuler la derniere annulation et revenir à l’état avant annulation. 

 

Afficher l’historique des modifications 
Utiliser le bouton   pour afficher/masquer le panneau à droite de la fenêtre du programme PLC 
Editor qui contient l’historique des derniers changements effectués. 

 

Redessiner la zone de dessin 
Si la zone de dessin n’est pas affichée correctement, appuyer sur le bouton   pour rafraichier 
l’écran et forcer le programme à tout redessiner. 
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Afficher information 

Utiliser le bouton   pour activer ou désactiver les ‘bulles’ d’information sur les blocs placés sur 
l’espace de travail. Si cette fonction est active et que la pointeur de la souris est située sur le bloc, une 
bulle s’affiche rappelant la configuration sommaire du bloc. 

 
PLC HINT 
 
 

Ajout de nouvelle page 

Utiliser le bouton   dans la barre d’outils PLC pour ajouter une nouvelle feuille à la fin du projet 
(après la dernière feuille existante). Déplacer les bords de la feuille pour adapter l’espace de travail 
nécessaire. 

 
REDIMENSIONNER LA FEUILLE 
 
NOTE:  
La fonction d’impression imprime chaque feuille du projet sur une page, les feuilles sont agrandies ou 
rétrécies pour s’adapter à la taille de la page. Ce procédé peut rendre difficile la lecture de certaines 
feuilles à l’origine très large.  
 
 

Exportation/importation des feuilles 

Utiliser le bouton   dans la barre d’outils PLC pour sauver la feuille actuellement sélectionnée 
dans un fichier.  
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Utiliser le bouton   dans la barre d’outils PLC pour importer le contenu du fichier vers la feuille 
actuellement sélectionnée.  

La configuration des sorties n’est pas importée et doit être fait manuellement. 

NOTE:  
L’importation efface et remplace touts les feuilles précédentes! 
 
ATTENTION!  
Veuillez verifier la configuration des Entrées de la feuille, spécialement dans le cas d’une importation 
d’une fonction qui a été créée pour une version différente du firmware ou d’une autre série de 
contrôleur.  
 
EXEMPLE:  
Ces fonctions sont surtout utilisées dans le cas où la feuille contient une fonction logique particulier 
qui sera régulièrement utilisé. Cela permet ainsi que créer une ‘bibliothèque’ de fonction.  
 
Déplacer une feuille 
Utiliser le bouton   ou   dans la barre d’outils PLC pour déplacer la feuille actuelle vers le haut 
ou vers le bas. 

ATTENTION!  
Déplacer les feuilles peut entrainer un ordre différent dans l’évalution des blocs et peut entraîner un 
résultat différent ou incorrect. 
 
ATTENTION!  
Déplacer les feuilles pourrait invalider certains blocs ‘Saut’. Veuillez vérifier chaque bloc ‘saut’ après 
avoir déplacer les feuilles. 
 
 

Aller à la prochaine/précédente feuille 

Utiliser le bouton   ou   dans la barre d’outils PLC pour activer la feuille précédente ou 
suivante. 

NOTE:  
La feuille active est indiquée par un contour bleu. 
 
 
Effacer une feuille 

Utiliser le bouton   dans la barre d’outils PLC pour effacer la feuille active. 
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Blocs logiques programmables 

Bloc PLC: ET/OU (AND/OR) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input 1..8 B N/A Entrées de 1..8 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Résultat de l’opération logique. 
 

Description Le bloc effectue une opération logique ET/OU (AND / OR) sur 2 - 8 opérandes 
binaires. Les entrées et la sortie peuvent être inversées. 

FONCTION AND 
I1 I2 O 

0 0 0 

0 1 0 

1 0 0 

1 1 1 
 
FONCTION OR 

I1 I2 O 

0 0 0 

0 1 1 

1 0 1 

1 1 1 
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1. Utiliser les boutons ‘+’,’-‘ pour ajouter/effacer des entrées (jusqu’à 8). 
2. Chaque etat des entrées peut être inversé. 
3. Renommer la sortie du bloc. 
4. Selectionner la fonction du bloc (OR ou AND). 
5. L’état de la sortie peut être inversé. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
 

 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

99 



 
 

 

Bloc PLC: XOR/RS 

Symbole 

 

Entrées ENTREE TYPE PLAGE [UNITE] FONCTION 

Input 1 B N/A Entrée 1 

Input 2 B N/A Entrée 2 
 

Sorties SORTIE TYPE PLAGE [UNITE] FONCTION 

Output B N/A Résultat de l’opération logique. 
 

Description Ce bloc fournit une fonction logique sur deux valeurs - XOR ou RS flip-flop. Les deux 
entrées et la sortie peuvent être inversées. 

FONCTION XOR 
I1 I2 O 

0 0 0 

0 1 1 

1 0 1 

1 1 0 
 
FONCTION RS 

R S ON-1 

0 0 Qn 

0 1 1 

1 0 1 

1 1 0 
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1. L’entrée 1 peut être inversée avant d’appliquer la fonction. 
2. L’entrée 2 peut être inversée avant d’appliquer la fonction. 
3. Renommer la sortie. La sortie peut être inversée. 
4. Pour finir, sélectionner le type de fonction. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Comparateur avec hystérésis 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur à comparer 

Input ON A Idem que 
l’entrée 

Valeur de Comparaison pour activer 
la sortie binaire 

Input OFF A Same as 'Input' Valeur de comparaison pour 
désactiver la sortie binaire 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Sortie du comparateur 
 

Description Le bloc compare la valeur de l’entrée avec les deux niveaux. Le résultat dépend 
si le niveau ON est supèrieur au niveau OFF et inversement. 
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1. Le niveau ON peut être une constant, dans ce cas écrire la valeur dans la 
zone de saisie. Autrement ajouter une entrée binaire sur la feuille et la 
relier virtuellement ‘par un cable’ au bloc.  

2. Le niveau OFF peut être une constant, dans ce cas écrire la valeur dans 
la zone de saisie. Autrement ajouter une entrée binaire sur la feuille et la 
relier virtuellement ‘par un cable’ au bloc.  

3. Renommer la sortie. 

NOTE:  
Utiliser le bouton représentant une croix (4) pour effacer la configuration actuelle 
de la source. 
 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Comparateur avec temporisation 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input 1 A Toute Valeur à comparer 

Input 2 A Idem que 
l’entrée 1 Niveau de comparaison 

Delay A 0.0..3000.0 [s] Activation différée de la sortie 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Sortie de la comparaison 
 

Description Le bloc marche comme un interrupteur analogique. Il compare la valeur de 
l’entrée avec le niveau de comparaison. Si la valeur d’entrée est supèrieur au 
niveau de comparaison, la sortie sera activée. La valeur Delay permet de différer 
l’activation de l’entrée. 

 
 

 

1. La valeur de comparaison peut être une constant, dans ce cas écrire la 
valeur dans la zone de saisie. Autrement ajouter une entrée sur la feuille 
et la relier virtuellement ‘par un cable’ au bloc.  

2. La valeur du délai peut être une constant, dans ce cas écrire la valeur 
dans la zone de saisie. Autrement ajouter une entrée sur la feuille et la 
relier virtuellement ‘par un cable’ au bloc.  

3. Renommer la sortie. 

NOTE:  
Utiliser le bouton représentant une croix (4) pour effacer la configuration actuel de 
la source. 
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NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Fenêtre de comparaison 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur à comparer 

Input HIGH A Idem que 
l’entrée Limite haute de la fenêtre 

Input LOW A Idem que 
l’entrée Limite basse de la fenêtre 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Resultat de la comparaison 
 

Description Le sortie binaire ‘Output’ est activée lorsque la valeur d’entrée est dans l’intervalle 
définie par la bornes inférieur (Low) et supérieur (High). 

 
 
 

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

106 



 
 

 

 
 

1. La borne inférieur peut être une constante, dans ce cas écrire 
directement la valeur dans la zone de saisie. Autrement ajouter une 
entrée sur la feuille et la relier virtuellement ‘par un cable’ au bloc.  

2. La borne supérieur peut être une constante, dans ce cas écrire 
directement la valeur dans la zone de saisie. Autrement ajouter une 
entrée sur la feuille et la relier virtuellement ‘par un cable’ au bloc.  

3. Renommer la sortie. 

NOTE:  
Utiliser le bouton représentant une croix (4) pour effacer la configuration actuel de 
la source. 
 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc logique : fonction mathématique I 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input 1 A Toute Entrée 1 

Input 2 A Idem que 
l’entrée 1 Entrée 2 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Idem que 
l’entrée 1 

Résultat de l’opération 
mathématique. 

 

Description Le bloc effectue une opération mathématique basic sur 2 opérandes. 

• ADD: Addition 
• SUB: Soustraction 
• ABS(SUB): Valeur absolue d’une soustraction 
• AVG: Moyenne 
• MIN: Retourne la valeur la plus basse des 2 entrées 
• MAX: Retourne la valeur la plus haute des 2 entrées 

 
 

1. Renommer la sortie 
2. Sélectionner l’opération mathématique 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.   
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Bloc PLC : Fonction Mathématique II 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input 1 A Toute Entrée n°1 

Input 2..8 A Idem que 
l’entrée n° 1 Entrées de 2 à 8 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Sortie A Idem que 
l’entrée n°1 

Résultat de l’opération 
mathématique 

 

Description Le bloc exécute des opérations mathématiques avec 2 à 8 opérandes. 

• ADD: Addition 
• AVG: Moyenne 
• MIN: Valeur Minimale 
• MAX: Valeur Maximale  

 
 

1. Utiliser les boutons pour ajouter/supprimer les entrées (jusqu’à 8) 
2. Renommer la sortie 
3. Selectionner la opération mathématique 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source. .  
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Bloc PLC : Interpolation 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A X1-X2 Entrée de la valeur 
 

Outputs SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Y1-Y2 Valeur transformée 
 

Description Ce bloc applique une transformation linéaire sur la valeur en entrée. La fonction 
de transformation est définie par deux paires de points [X1, Y1] et [X2, Y2]. Le 
bloc peut être utilisé par exemple pour changer la précision décimale d’une 
valeur. 

 
 

 
 

1. Renommer la sortie. 
2. Ajuster la précision de la sortie (nombre de décimale). 
3. Ajuster l’unité de mesure de la sortie. 
4. Saisir les points de la fonction de transformation linéaire. La valeur de X1 

doit être inférieure à la valeur de X2. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC : Interpolation – configurable (Type ‘B’) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A X1-X2 Entrée de la valeur 

X1 A -32000/+32000 Limite basse X 

X2 A -32000/+32000 Limite haute X 

Y1 A -32000/+32000 Limite basse Y 

Y2 A -32000/+32000 Limite basse Y 
 

Outputs SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Y1 / Y2 Valeur transformée 

Oor B N/A Entrée hors plage 

Err B N/A Valeur en sortie non valide 
 

Description Ce bloc applique une transformation linéaire sur la valeur en entrée. La fonction 
de transformation est définie par deux paires de points [X1, Y1] et [X2, Y2]. Si la 
valeur en entrée est compris entre X1 et X2, la valeur en sortie sera donnée par 
la conversion, si la valeur en entrée est hors plage, la sortie prendra la valeur Y1 
ou Y2 (la sortie binaire OOR sera activé). Tous les paramètres peuvent être 
définis comme constante ou assignés à une valeur analogique / consigne du 
contrôleur. La résolution de toutes les entrées est automatiquement définie par 
l’entrée de la fonction. Si l’une des entrées de la fonction est non valide, la sortie 
binaire Err sera activée et la sortie de la fonctionne prendra la valeur -32768. 
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1. Renommer la sortie. 
2. Ajuster la précision de la sortie (nombre de décimale). 
3. Ajuster l’unité de mesure de la sortie. 
4. Saisir les points de la fonction de transformation linéaire ou sélectionner 

la valeur source de chaque point. La valeur de X1 doit être inférieure à la 
valeur de X2, de même pour Y1 et Y2. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
 
NOTE:  
Ce bloc est disponible uniquement à partir du firmware 3.0 ou supérieur  
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Bloc PLC : Fonction mathématique Multiplication/Division  (AxB/C) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Entrée A A Toute Multiplicande 

Entrée B A Idem Multiplicateur 

Entrée C A Idem Diviseur 
 

Outputs SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Idem Résultat de l’opération 

Err B N/A Indique un résultat non valide 
 

Description Ce bloc Multiplication/Division (AxB/C) réalise un calcul mathématique de trois 
valeurs (la multiplication et la division). La fonction peut être utilisée par exemple 
pour la mise à l’échelle de valeurs. Dans le cas de résultat invalide ou de valeurs 
en entrée non valide, la sortie de la fonction donnera une valeur de -32768 et la 
sortie binaire Err sera activée. Le produit de la multiplication AxB est calculé en 
premier et est stocké dans une variable de 32 bits. Cependant comme la sortie 
est uniquement de 16 bits, le diviseur de l’opération (Entrée C) doit être 
correctement choisi pour permettre d’obtenir une valeur en résultat dans la plage 
de -32767 à +32767. 

 
 
 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
 
NOTE:  
Ce bloc est disponible uniquement à partir du firmware 3.0 ou supérieur  
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Bloc PLC: Régulateur PID avec sortie analogique 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

I A Toute Valeur à réguler 

Gate B N/A Entrée Marche/Arret de la régulation 

Req A Idem que 'input' Valeur requise 

Gain A -100.00..100.00 
[%] Gain du régulateur 

Int A -100.00..100.00 
[%] Partie intégrante de la régulation 

Der A -100.00..100.00 
[%] Partie dérivée de la régulation 

Bias A -10000..10000 [-
] 

Value par défaut lorsque la régulation 
n’est pas activée 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

O A -10000..10000 [-] Sortie qui controle l’actuationneu 
 

Description Le bloc est un régulateur de PID avec une sortie analogique et une période de 
régulation ajustable. La fonction de régulation peut être désactivée par l’entrée 
binaire ‘Gate’. Lorsque la régulation n’est pas active, la valeur de sortie est 
définie par l’entrée ‘Bias’. 
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1. Renommer la sortie. 
2. Ajuster la période de régulation. Cette période doit être définie en 

fonction du temps de réponse du système, ex. : une longue période pour 
des systèmes lents, une courte période pour des systèmes rapides.  

3. Certains paramètres de régulations sont disponibles comme par exemple 
la partie dérivée, seuil, constante. Dans le cas d’une constante, écrire 
directement dans la zone de saisie. Effacer la source configurée au 
préalable pour écrire la constante.  

4. Si l’on souhaite que la régulation ne soit active que dans certaines 
conditions, utiliser l’entrée ‘gate’. Créer une valeur binaire définie par une 
condition (ex utiliser un autre bloc plc) et la connecter à l’entrée ‘gate’, la 
régulation sera alors utilisée si l’entrée ‘Gate’ est active. Si l’entrée ‘Gate’ 
n’est pas attribuée, la régulation se fera tant que le contrôleur est sous 
tension.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Régulateur PID avec sortie analogique (type ‘B’) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

I A Toute Valeur à réguler 

Gate B N/A Entrée Marche/Arret de la régulation 

Req A Idem que 'input' Valeur requise 

Gain A -100.00..100.00 
[%] Gain du régulateur 

Int A -100.00..100.00 
[%] Partie intégrante de la régulation 

Der A -100.00..100.00 
[%] Partie dérivée de la régulation 

Bias A -10000..10000 [-
] 

Value par défaut lorsque la régulation 
n’est pas activée 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Sortie A -10000..10000 [-] Sortie qui controle l’actuationneu 
 

Description Le bloc est un régulateur de PID avec une sortie analogique et une période de 
régulation ajustable. La fonction de régulation peut être désactivée par l’entrée 
binaire ‘Gate’. Lorsque la régulation n’est pas active, la valeur de sortie est 
définie par l’entrée ‘Bias’. 
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1. Renommer la sortie. 
2. Ajuster la période de régulation. Cette période doit être définie en 

fonction du temps de réponse du système, ex. : une longue période pour 
des systèmes lents, une courte période pour des systèmes rapides.  

3. Si l’on souhaite que la régulation ne soit active que dans certaines 
conditions, utiliser l’entrée ‘gate’. Créer une valeur binaire définie par une 
condition (ex utiliser un autre bloc plc) et la connecter à l’entrée ‘gate’, la 
régulation sera alors utilisée si l’entrée ‘Gate’ est active. Si l’entrée ‘Gate’ 
n’est pas attribuée, la régulation se fera tant que le contrôleur est sous 
tension.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Régulateur PID avec sortie analogique (type ‘C’) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur à réguler 

Gate B N/A Entrée Marche/Arret de la régulation 

Req A Idem que 'input' Valeur requise 

Gain A -100.00..100.00 
[%] Gain du régulateur 

Int A -100.00..100.00 
[%] Partie intégrante de la régulation 

Der A -100.00..100.00 
[%] Partie dérivée de la régulation 

Bias A -10000..10000 [-
] 

Value par défaut lorsque la régulation 
n’est pas activée 

Per A 0,0..600,0 [s] Période de la régulation (temps de 
réponse du système) 

Low A -10000..10000[-] 

Limite basse de la sortie, si la sortie 
dépasse cette valeur, la boucle 
interne est bloquée, normalement 
définie sur -10000 

High A -10000..10000[-] 

Limite haute de la sortie, si la valeur 
dépasse cette valeur, la boucle 
interne est bloquée, normalement 
définie sur +10000 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

O A -10000..10000 [-] Sortie qui controle l’actuationneu 

Lo B N/A La sortie confirme que la sortie a 
atteinte la valeur limite basse 

HI B N/A La sortie confirme que la sortie a 
atteinte la valeur limite haute 

 

Description Le bloc est un régulateur de PID avec une sortie analogique et une période de 
régulation ajustable. La fonction de régulation peut être désactivée par l’entrée 
binaire ‘Gate’. Lorsque la régulation n’est pas active, la valeur de sortie est 
définie par l’entrée ‘Bias’. 
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1. Renommer la sortie. 
2. Ajuster la période de régulation. Cette période doit être définie en 

fonction du temps de réponse du système, ex. : une longue période pour 
des systèmes lents, une courte période pour des systèmes rapides.  

3. Si l’on souhaite que la régulation ne soit active que dans certaines 
conditions, utiliser l’entrée ‘gate’. Créer une valeur binaire définie par une 
condition (ex utiliser un autre bloc plc) et la connecter à l’entrée ‘gate’, la 
régulation sera alors utilisée si l’entrée ‘Gate’ est active. Si l’entrée ‘Gate’ 
n’est pas attribuée, la régulation se fera tant que le contrôleur est sous 
tension.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
 
ATTENTION!  

• l’entrée limite basse doit toujours être inférieure à l’entrée limite haute 
sinon la valeur en sortie du régulateur sera toujours égale à la valeur de 
la limite basse. 

• Si la limite basse est égale à la limte haute alors la sortie du régulateur 
sera égale à l’une des deux entrées (étant donné qu’elles sont 
identiques) 

• S’il y a une valeur invalide (-32768) sur l’entrée du régulateur, la sortie 
sera définie avec la valeur de l’entrée BIAS. 

• La valeur donnée en sortie lorsque l’entrée BIAS est active (l’entrée 
GATE n’est pas active et il n’y a pas de valeurs invalides sur les entrées) 
n’est pas limitée par les valeurs des limites haute et basse. La valeur en 
sortie correspond à la valeur de l’entrée BIAS avec une plage pouvant 
aller de -10000 à +10000. 

 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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NOTE:  
Le bloc n’est disponible qu’à partirr de la version 3.0 ou supérieur.  
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Bloc PLC : Régulateur PID avec sortie binaire monter/descendre 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur à réguler 

Valeur 
demandée A Idem à l’entrée Valeur requise 

Gain A 
-
100.00..100.00 
[%] 

Gain du régulateur 

Int A 
-
100.00..100.00 
[%] 

Partie intégrante de la régulation 

Der A 
-
100.00..100.00 
[%] 

Partie dérivée de la régulation 

Gate B N/A Entrée Régulateur marche/arret 
 

Sortie OUTPUT TYPE RANGE[DIM] FUNCTION 

Up B N/A Contrôle actionneur – Augmenter 

Down B N/A Contrôle actionneur - Diminuer 
 

Description Le bloc est un régulateur PID avec deux sorties binaires Monter/Descendre 
et une période d’ajustement de la régulation. La fonction de la régulation peut 
être désactivée par l’entrée binaire ‘gate’. 
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1. Renommer les sorties. 
2. Ajuster la période de régulation. La période doit être ajustée en 

fonction du temps de réponse du système, ex. : longue période pour 
des systèmes lents, période courte pour des systèmes rapides.  

3. Ajuster le compteur de l’action. C’est le temps que l’actionneur (servo 
etc.) exige pour s’ouvrir ou se fermer complètement.  

4. Certains paramètres de régulation sont parfois nécessaires comme 
par exemple la partie dérivation. Dans ce cas saisir une constante 
directement dans la zone appropriée. Si une source est configurée, 
elle doit être supprimée pour pouvoir saisir une constante.  

5. Si le régulateur ne doit s’activer que dans certaines conditions, 
utiliser l’entrée  ‘Gate’. Créer une valeur binaire générée par les 
conditions (ex utiliser d’autre bloc plc) et l’attribuer à l’entrée binaire 
‘gate’. Si l’entrée ‘Gate’ n’est pas attribuée, la régulation se fera tant 
que le contrôleur est sous tension.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
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Bloc PLC : Régulateur PID avec sortie binaire Monter/Descendre (type ‘B’) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

I A Toute Valeur à réguler 

GATE B N/A Entrée Régulateur marche/arret 

Req A Idem à l’entrée Valeur requise 

GAIN A 
-
100.00..100.00 
[%] 

Gain du régulateur 

INT A 
-
100.00..100.00 
[%] 

Partie intégrante de la régulation 

DER A 
-
100.00..100.00 
[%] 

Partie dérivée de la régulation 

Per A 0.1 – 600.0[s] 

Période de la régulation. La 
période devrait être ajustée en 
fonction de la réaction de 
l’installation, par exemple une 
longue période pour une réponse 
lente et une courte période pour 
une réponse rapide. 

TAct A 0.1 – 60,0 [s] 

Delai de l’actionneur. C’est le 
temps nécessaire qu’il faut à un 
actionneur (servo, etc) pour 
passer de l’état fermé (0%) à 
l’état ouvert (100%). 

 

Sortie OUTPUT TYPE RANGE[DIM] FUNCTION 

Up B N/A Contrôle actionneur – Augmenter 

Down B N/A Contrôle actionneur - Diminuer 
 

Description Le bloc est un régulateur PID avec deux sorties binaires Monter/Descendre 
et une période d’ajustement de la régulation. La fonction de la régulation peut 
être désactivée par l’entrée binaire ‘gate’. 
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1. Renommer les sorties. 
2. Ajuster la période de régulation. La période doit être ajustée en 

fonction du temps de réponse du système, ex. : longue période pour 
des systèmes lents, période courte pour des systèmes rapides.  

3. Si le régulateur ne doit s’activer que dans certaines conditions, 
utiliser l’entrée  ‘Gate’. Créer une valeur binaire générée par les 
conditions (ex utiliser d’autre bloc plc) et l’attribuer à l’entrée binaire 
‘gate’. Si l’entrée ‘Gate’ n’est pas attribuée, la régulation se fera tant 
que le contrôleur est sous tension.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
 
NOTE:  
Ce bloc n’est disponible que pour certains firmwares spécifiques. 
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Bloc PLC: Rampe analogique 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Entrée devant subir la rampe 

Up A Idem que 
l’entrée 

Augmentation maxi que peut subir 
la valeur par seconde. 

Down A Idem que 
l’entrée 

Diminution maxi que peut subir la 
valeur par seconde. 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

O A Idem que 
l’entrée Valeur ajustée 

 

Description Ce bloc limite les variations que peut subir une valeur en sortie par seconde. 
Les valeurs maxi et mini sont ajustables séparéments. Les rampes haute et 
basse peuvent être activées/désactivées séparement. 

 
 

1. Ajuster l’augmentation maximale de la sortie par seconde. Pour un 
délai constant, écrire la valeur dans la zone de saisie sinon 
connecter l’entrée à tout autre objet analogue.  

2. Ajuster la diminution maximale de la sortie par seconde. Pour un 
délai constant, écrire la valeur dans la zone de saisie sinon l’entrée à 
tout autre objet analogue. 

3. Cocher la case pour activer la limitation haute par seconde. 
4. Cocher la case pour activer la limitation basse par seconde. 
5. Renommer la sortie. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
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Bloc PLC: Monter/Descendre 

Symbole 

 

Entrées ENTREES TYPE PLAGE[UNITE] FONCTION 

Lim 1 A -32768..32767 [-] Limite basse de la sortie analogique 

Lim 2 A -32768..32767 [-] Limite haute de la sortie analogique 

SpUp A -32768..32767 [-] Taux de l’accélération par seconde de 
la sortie analogique 

SpDn A -32768..32767 [-] Taux du ralentissementt par seconde 
de la sortie analogique 

DefO A -32768..32767 [-] 

Valeur par défaut de la sortie. La 
sortie est initialisée à cette valeur 
lorsque le contrôleur est mis sous 
tension ou lorsque l’entrée de 
réinitialisation est activée.  

Up B N/A 
La valeur de sortie est augmentée du 
taux d’accélération quand cette entrée 
est active. 

Dn B N/A 
La valeur de sortie est diminuée 
proportionnellement au taux fixé 
quand cett entrée est active. 

Res B N/A La sortie est réinitialisée à sa valeur 
de sortie par defaut. 

 

Outputs SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Lim1..Lim2 [-] Valeur de sortie 
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Description Ce bloc travaille comme une rampe analogique contrôlée par les entrées binaire “Up” 
et “Down”. La vitesse de la rampe et les limites sont ajustables comme la valeur par 
défaut. La sortie peut être réinitialisée à sa valeur par default (seuil) par l’entrée 
Reset. 

 

1. Ajuster les limites de sortie. Pour des valeurs constantes, indiquer dans la 
zone de saisie ces valeurs sinon connecter les entrées à n’importe quel objet 
analogique (ex. Consigne PLC (PLC setpoints) ).  

2. Ajuster la vitesse d’incrémentation et de décrémentation de la sortie. Pour des 
valeurs constantes, indiquer dans la zone de saisie ces valeurs sinon 
connecter les entrées à n’importe quel objet analogique (ex. Consigne PLC 
(PLC setpoints)).  

3. Ajuster la valeur par défaut de la sortie. Pour une valeur constante, indiquer 
dans la zone de saisie cette valeur sinon connecter l’entrée à n’importe quel 
objet analogique (ex. Consigne PLC (PLC setpoints) ).  

4. Renommer la sortie. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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PLC Block: Incrémenter/Désincrémenter 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Inc B N/A Incrémente la sortie de 1. 

Dec B N/A Déincrémente la sortie de 1. 

Res B N/A Réinitialise la sortie à sa valeur par 
défaut.  

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A 0..Max [-] Valeur de sortie 
 

Description La valeur en sortie du bloc est incrémentée ou désincrémentée à chaque 
activation d’une des entrées du bloc. La valeur initiale et la valeur maximale 
peuvent être renseignées. La valeur de sortie peut être réinitialisée à sa valeur 
initiale par l’entrée ‘Reset’. Le bloc peut fonctionner de manière cyclique ou non 
(ex : mode cyclique ...4-5-0-1-2-3-4-5-0-1..., mode non cyclique ...0-0-1-2-3-4-5-
5...). 

EXEMPLE:  
Ce module peut être utilisé par exemple avec les blocs Decomposer et Constantes 
multiplexés pour basculer d’une caméra à une autre.  

 
EXAMPLE: CAMSWITCH  
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1. Ajuster la limite supérieure de la sortie. 
2. Ajuster la valeur initiale de la sortie après réinitialisation. 
3. Choisir le mode du bloc : cyclique ou non. 
4. Renommer la sortie. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.   
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Bloc PLC: Moyenne dynamique 

Symbole 

 

Entrée ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur de départ 
 

Sortie SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Idem à 
l’entrée 

Moyenne dynamique des valeurs 
de l’entrée 

 

Description La fonction cacule une moyenne des N dernièrs échantillons de la valeur de 
l’entrée. Le taux de l’échantillon est ajustable. 

L’utilisation typique de cette fonction est la filtration d’une valeur (quantité) 
qui fluctue rapidement et instantanément mais qui doit changer lentement. 
L’utilisation d’une valeur filtrée peut éviter certains problèmes dans le 
traitement suivant de la valeur (exemple dans d’autre bloc PLC ou dans un 
systeme de supervision). 

Exemple d’une telle valeur peut être la puissance du groupe électrogène au 
gaz en parallèle sur le réseau. Même si la valeur moyenne est constante, la 
valeur peut flutuer rapidement en raison des ratés d’allumage. 

 
 

1. Renommer l’entrée. 
2. Le nombre d’échantillon est donné en puissance de 2. Ex ajuster à 3 

pour 8 échantillons, 4 pour 16, 5 pour 32… 
3. Ajuster la vitesse de l’échantillonage. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
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Bloc PLC: Moyenne dynamique (type ‘B’) 

Symbole 

 

Entrée ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur de départ 

ExpW A 1..5 [] Valeur expotenciel 

Per A 100-5000 [ms] Valeur de la période 
 

Sortie SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Idem à 
l’entrée 

Moyenne dynamique des valeurs 
de l’entrée 

 

Description La fonction cacule une moyenne des N dernièrs échantillons de la valeur de 
l’entrée. Le taux de l’échantillon est ajustable. 

L’utilisation typique de cette fonction est la filtration d’une valeur (quantité) 
qui fluctue rapidement et instantanément mais qui doit changer lentement. 
L’utilisation d’une valeur filtrée peut éviter certains problèmes dans le 
traitement suivant de la valeur (exemple dans d’autre bloc PLC ou dans un 
systeme de supervision). 

Exemple d’une telle valeur peut être la puissance du groupe électrogène au 
gaz en parallèle sur le réseau. Même si la valeur moyenne est constante, la 
valeur peut flutuer rapidement en raison des ratés d’allumage. 

 
 

1. Renommer l’entrée. 
2. Le nombre d’échantillon est donné en puissance de 2. Ex ajuster à 3 

pour 8 échantillons, 4 pour 16, 5 pour 32… 
3. Ajuster la vitesse de l’échantillonage. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
 
NOTE:  
Le bloc n’est disponible que pour certains firmwares spécifiques.  

GenConfig, version logicielle 3.5, ©ComAp – Juin 2013 
Source : GenConfig-3.0-Reference guide.pdf                                              

 

131 



 
 

 

Bloc PLC: Minuterie 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Run B N/A 
Le compte à rebours se décrémente 
seulement si cette entrée est activée 
ou non connectée 

Rel B N/A Cette entrée réinitialise le compte à 
rebours à sa valeur initiale 

RelV A 0..32767 [-] Valeur initiale du compte à rebours. 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Sortie Compte à rebours 
 

Description Le bloc travaille comme un compte à rebours qui est décrémenté de 1 à chaque cycle 
PLC. La valeur initiale est ajustable par l’entrée "Reload val". Comme chaque cycle 
PLC dure 100 ms, la durée du compte à rebours est équivalent à "Reload val"/10 
second. Le compteur est automatiquement réinitialisé à sa valeur de départ lorsqu’il 
arrive à zéro ou lorsque l’entrée ‘Reload’ est activée. Le compteur est bloqué à sa 
valeur de départ (Reload val) tant que l’entrée ‘Reload’ est activée. La sortie du 
compteur est toujours inversée à la réinitialisation du compteur. 

 

 

1. Ajuster la valeur de l’entrée ‘reload value’. La durée du compteur (en 
secondes) est obtenue en divisant la valeur ‘Reload Value’ par 10. Cette 
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valeur peut être une constante, une consigne ou un objet analogique.  
2. Renommer la sortie. 
3. Si l’état de la  sortie doit être au départ à ‘0’, cocher la case ‘First down’ sinon 

elle sera à l’état logique de ‘1’. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source. .  
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Bloc PLC: Délai 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input B N/A Entrée du signal devant être différée 

Input time up A -3200.0..3200.0 
[s] 

Délai avant l’activation de la sortie 
lorsque l’entrée est activée 

Input time 
down A -3200.0..3200.0 

[s] 
Délai avant la désactivation de la 
sortie lorsque l’entrée est désactivée 

Input reset B N/A 
Réinitialise la sortie binaire à 0. La 
sortie sera désactivée alors que 
l’entrée est active. 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Signal de Sortie binaire 
 

Description Le bloc peut avoir deux modes de fonctionnement :  

• Mode différé – La sortie est mise en position haute après un délai donnée 
par "input time up" quand l’entrée est détectée en position haute. La sortie 
est mise en position basse après un délai donné par "input time down" quand 
l’entrée est détectée en position basse. Si la demande de position basse est 
générée avant la demande de position haute, aucune impulsion n’est 
générée vers la sortie.  

• Mode Impulsion – La sortie est activée à chaque changement d’état de 
l’entrée durant la période donnée pour "input time up" et "input time down". Si 
l’entrée est activée, la sortie sera activée pendant la période indiquée par 
‘input time up’, Si l’entrée est désactivée, la sortie sera activée pendant la 
période indiquée par ‘input time down’  
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1. Ajuster le délai/retard pour la position haute. Ecrire la valeur dans la zone de 
saisie dans le cas d’une constante sinon attribuer l’entrée à n’importe quel 
objet analogique.  

2. Ajuster le délai/retard pour la position basse. Ecrire la valeur dans la zoone 
de saisie dans le cas d’une constante sinon attribuer l’entrée à n’importe quel 
objet analogique.  

3. Renommer la sortie. 
4. Choisir le type de fonctionnement du bloc (voir plus haut) 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.   
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Bloc PLC: Délai – s/min/h (type ‘B’) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input B N/A Entrée du signal devant être différée 

Input time up A -3200.0..3200.0 
[s, m, h] 

Délai avant l’activation de la sortie 
lorsque l’entrée est activée 

Input time 
down A -3200.0..3200.0 

[s, m, h] 
Délai avant la désactivation de la 
sortie lorsque l’entrée est désactivée 

Input reset B N/A 
Réinitialise la sortie binaire à 0. La 
sortie sera désactivée alors que 
l’entrée est active. 

 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output B N/A Signal de Sortie binaire 
 

Description Le bloc peut avoir deux modes de fonctionnement :  

• Mode différé – La sortie est mise en position haute après un délai donnée 
par "input time up" quand l’entrée est détectée en position haute. La sortie 
est mise en position basse après un délai donné par "input time down" quand 
l’entrée est détectée en position basse. Si la demande de position basse est 
générée avant la demande de position haute, aucune impulsion n’est 
générée vers la sortie.  

• Mode Impulsion – La sortie est activée à chaque changement d’état de 
l’entrée durant la période donnée pour "input time up" et "input time down". Si 
l’entrée est activée, la sortie sera activée pendant la période indiquée par 
‘input time up’, Si l’entrée est désactivée, la sortie sera activée pendant la 
période indiquée par ‘input time down’  
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1. Ajuster le délai/retard pour la position haute. Ecrire la valeur dans la zone de 
saisie dans le cas d’une constante sinon attribuer l’entrée à n’importe quel 
objet analogique.  

2. Ajuster le délai/retard pour la position basse. Ecrire la valeur dans la zoone 
de saisie dans le cas d’une constante sinon attribuer l’entrée à n’importe quel 
objet analogique.  

3. Renommer la sortie. 
4. Sélectionner l’unité de temps (seconde, minute, heure) 
5. Choisir le type de fonctionnement du bloc (voir plus haut) 

NOTE:  
Si les entrées timpe up ou time down sont inférieures à zéro, l’entrée est en interne 
fixé à 0.   
 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.   
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NOTE:  
Ce bloc est disponible à partir de la version firmware 3.0.   
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Bloc logique: Interrupteur Analogique (Relais) 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input 1 A Toutes Valeur d’entrée 1 

Input 2 A Idem que 
l’entrée n°1 Valeur d’entrée 2 

Input SW B N/A Entrée Interrupteur 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Sortie A Idem à l’entrée 
n°1 

Copie de l’entrée n°1 ou n°2 selon 
l’état de l’entrée binaire SW 

 

Description Le bloc opère comme un relais. Si l’entrée binaire SW est inactive, le bloc renvoie 
la valeur de l’entrée analogique n°1 vers la sortie analogique. Si l’entrée binaire 
SW est actif, le bloc renvoie la valeur de l’entrée analogique n°2 vers la sortie 
analogique. 

 
 

 

1. L’entrée 1 peut être une constante, dans ce cas écrire la constante dans 
la zone de saisie. Sinon dans la feuille, créer une entrée et la relier au 
bloc en ‘tirant’ un cable virtuel.  

2. L’entrée 2 peut être une constante, dans ce cas écrire la constante dans 
la zone de saisie. Sinon dans la feuille, créer une entrée et la relier au 
bloc en ‘tirant’ un cable virtuel.  

3. Renommer la sortie. 

NOTE: 
Utiliser le bouton représentant une croix (4) pour effacer la configuration actuelle 
de la source. 
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NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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Bloc PLC: Enregistrement historique forcé 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input B N/A 

Un enregistrement avec le texte 
configuré est enregistré dans 
l’historique du contrôleur lorsque 
l’entrée est activée. 

 

Sorties  

Description Ce bloc écrit un enregistrement avec un texte défini dans l’historique lorsque 
l’entrée est activée. 

 
 

1. Entrer le texte, qui sera écrit dans la colonne ‘raison’ du journal des 
évènements (historique). 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.   
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Bloc PLC: Protection forcée 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Lvl 1 B N/A 
L’entrée active une alarme de  
niveau ‘jaune’ de la protection 
configurée (si elle a été définie). 

Lvl 2 B N/A 
L’entrée active une alarme de   
niveau ‘rouge’ de la protection 
configurée (si elle a été définie). 

Sf B N/A 

L’entrée active une alarme de 
défaut de capteur si une 
protection de niveau ‘rouge’ est 
configurée. 

 

Sorties  

Description Le bloc génére des alarmes du type configuré et avec le texte donné lorsque 
l’entrée binaire appropriée est activée. 

 
 

1. Selectionner le type de protection dans la liste. 
2. Saisir le texte qui apparaîtra dans la liste des alarmes avec le préfixe 

correspondant au niveau de la protection lorsque la protection sera 
activée.  

3. Relier sur la feuille les entrées. Les entrées du bloc seront 
disponibles ou non selon le type de protection (ex si une alerte est 
sélectionnée l’entrée "Lvl 2" ne sera pas disponible). De ce fait, les 
types de protections doivent être sélectionnés avant de relier les 
entrées.  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.   
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Bloc PLC: Saut 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input B N/A Entrée qui active le saut. 
 

Sorties  

Description Si l’entrée est activée alors le groupe de bloc PLC suivant sera ignoré et 
l’exécution des fonctions PLC reprendra au bloc spécifié dans le bloc Saut 
(jump). 

 
 

1. Définir si l’etat de l’entrée binaire sera inversé. 
2. Sélectionner le bloc de destination où le saut devra avoir lieu. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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 Bloc PLC: Constante analogique Multiplexée 

Symbole 

 

Entrée ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A 0..31 [-] Sélectionne la constante qui sera 
envoyée vers la sortie analogique 

 

Sortie SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Adjustable Valeur de la sortie sera l’une des 
constantes sélectionnées par l’entrée 

 

Description Le bloc permet de définir une constante parmi d’autres en fonction d’une valeur 
analogique. La valeur de la sortie est définie en fonction de l’index correspondant 
la valeur de l’entrée. Ce bloc peut être utilisé par exemple pour passer d’une 
caméra à une autre comme décrit dans la partie Inc/Dec. 
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1. Renommer la sortie. 
2. Ajuster la résolution et les unités. 
3. Utiliser les boutons pour ajouter/supprimer des constantes (jusqu’à 32). 
4. Ajuster les valeurs des constantes. La colonne "Item" (4.1) représente 

l’index des constantes, qui sera utilisée pour la sélection de la valeur de 
sortie. La valeur de la constante peut être saisie sous forme numérique 
(4.2) ou sous forme binaire (4.3).  

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.  
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PLC Block: Compteur 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input Cnt B N/A Entrée activant l’incrémentation 

Input Lim A 0..32767 [-] Limite avant activation de la 
sortie. 

Input Clr B N/A Entrée de réinitialisation 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Sortie B N/A La sortie est activée lorsque le 
compteur dépasse la borne fixée 

 

Description Le bloc marche comme un compteur borné avec une entrée de remise à zero 
et une entrée pour la limite ajustable. Le compteur peut avoir la valeur 
maximale de 32767. Cette valeur n’est pas mémorisée lorsque le contrôleur 
est éteint. La sortie binaire est active lorsque le compteur dépasse la limite 
ajustée et le reste jusqu’à la réinitialisation du compteur. L’activation de 
l’entrée de réinitialisation remet à zero le compteur et désactive la sortie 
binaire. Si l’entrée de réinitialisation est maintenu active, le compteur est 
bloqué à zéro. 

 
 

1. Ajuster la valeur limite. La sortie binaire est active si le compteur 
dépasse cette valeur. La limite peut être une constante, un point de 
consigne ou toute autre valeur analogique.  

2. Renommer la sortie. 
3. Sélectionner l’etat de l’entrée qui incrémentatera le compteur. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.  
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 PLC Block: Decomposer 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Valeur a décomposer en bits 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Out 1 B N/A Bit 0,4,8,12 – selon le groupe de 
bits sélectionné. 

Out 2 B N/A Bit 1,5,9,13 - selon le groupe de 
bits sélectionné. 

Out 3 B N/A Bit 2,6,10,14 - selon le groupe de 
bits sélectionné. 

Out 4 B N/A Bit 3,7,11,15 - selon le groupe de 
bits sélectionné. 

 

Description Le bloc convertit la valeur d’entrée analogique sous forme binaire et fournit 
ainsi des sorties binaire. Le bloc peut être utilisé par exemple pour créer un 
sélecteur de caméra comme décrit dans la partie Inc/Dec. 

 
 

1. Selectionner le groupe de bits qui sera mappé sur les sorties. 
2. Ecrire un nombre dans la zone de saisie pour voir sa forme binaire 

(1). Cette zone permet seulement de faire un test et n’influence pas 
le bloc.  

3. Selectionner les sorties qui seront utilisées et les renommer. 

NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien 
entre l’entrée et la source.   
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PLC Block: Convertisseur 

Symbole 

 

Entrées ENTREE TYPE PLAGE[UNITE] FONCTION 

Input A Toute Entrée 
 

Sorties SORTIE TYPE PLAGE[UNITE] FONCTION 

Output A Ajustable Sortie 
 

Description Le bloc converti la valeur en entrée de n’importe quel type en une valeur entière 
(16 bits). Si la valeur ne peut être convertie (hors plage), la valeur de sortie sera 
défini avec la valeur 0x8000 (invalid status). 

 
 
NOTE:  
Les entrées sont assignées à leur source dans la feuille en ‘tirant’ un lien entre 
l’entrée et la source.   
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